The information in this document is subject to change without notice and does not represent a commitment on the part of Native Instruments GmbH. The software described by this document is subject to a License Agreement and may not be copied to other media. No part of this publication may be copied, reproduced or otherwise transmitted or recorded, for any purpose, without prior written permission by Native Instruments GmbH, hereinafter referred to as Native Instruments.

“Native Instruments”, “NI” and associated logos are (registered) trademarks of Native Instruments GmbH.

Mac, Mac OS, GarageBand, Logic, iTunes and iPod are registered trademarks of Apple Inc., registered in the U.S. and other countries.
Windows, Windows Vista and DirectSound are registered trademarks of Microsoft Corporation in the United States and/or other countries.
All other trade marks are the property of their respective owners and use of them does not imply any affiliation with or endorsement by them.

Document authored by: Native Instruments GmbH
Software version: 2.6.4 (05/2013)

Special thanks to the Beta Test Team, who were invaluable not just in tracking down bugs, but in making this a better product.
# Table of Contents

1  Welcome to the World of TRAKTOR KONTROL S2! ............................................................ 11
   1.1  What Is TRAKTOR KONTROL S2? .................................................................................. 11
   1.2  The TRAKTOR KONTROL S2 Documentation at a Glance ........................................... 12
      1.2.1  Which Documents Are There? .............................................................................. 12
      1.2.2  Recommended Reading Order ................................................................................ 13
      1.2.3  In This Manual ....................................................................................................... 13
   1.3  System Requirements .................................................................................................. 14
2  TRAKTOR KONTROL S2 Quick Overview ......................................................................... 15
3  Preparing Your Music Library ...................................................................................... 18
   3.1  What Is the Track Collection? ....................................................................................... 18
   3.2  Importing Music Folders ............................................................................................. 19
   3.3  Tracks Managed by iTunes .......................................................................................... 20
      3.3.1  Playing Tracks Managed by iTunes ........................................................................ 20
      3.3.2  Importing a Selection of Tracks from iTunes ........................................................ 21
      3.3.3  Importing iTunes Playlists .................................................................................... 22
4  Tutorials .......................................................................................................................... 23
   4.1  Playing Your First Track .............................................................................................. 23
      4.1.1  Quick-Loading a Track ........................................................................................... 24
      4.1.2  Playing the Track .................................................................................................... 26
      4.1.3  If You Don’t Hear the Track ................................................................................ 27
   4.2  Mixing In a Second Track ........................................................................................... 29
      4.2.1  Loading and Playing the Second Track .................................................................. 29
      4.2.2  Using Headphones to Prepare the Mix .................................................................. 30
      4.2.3  Synchronizing the Second Track ........................................................................... 30
      4.2.4  Setting a Cue Point as Starting Point ................................................................... 31
      4.2.5  Interlude: In Case the Left Track Has Reached Its End .......................................... 33
Table of Contents

4.2.6 Mixing In the Track by Using the Channel EQ and Filter ................................................. 33
4.2.7 Doing Everything by Hand .......................................................................................... 34

4.3 Adjusting Levels ........................................................................................................................ 37
  4.3.1 The Theory ................................................................................................................ 37
  4.3.2 The Practice ............................................................................................................... 38

4.4 Looping and Cueing ................................................................................................................... 41
  4.4.1 Playing with Loops .................................................................................................... 41
  4.4.2 Using Hotcues ........................................................................................................... 44

4.5 Using Samples in Your Mix ......................................................................................................... 46
  4.5.1 Loading a Sample from the Collection .................................................................... 47
  4.5.2 Triggering the Sample ............................................................................................... 49
  4.5.3 Capturing a Sample from a Track Deck ................................................................. 50
  4.5.4 Unloading a Sample .................................................................................................. 52

4.6 Adding FX ................................................................................................................................... 52
  4.6.1 Group Mode ............................................................................................................ 53
  4.6.2 Getting the FX Unit Ready ....................................................................................... 54
  4.6.3 Assigning Decks to the FX Unit and Bringing In the FX .............................................. 55
  4.6.4 Controlling the FX Unit .............................................................................................. 55
  4.6.5 Single Mode ............................................................................................................ 56
  4.6.6 Storing a Snapshot of an FX UNIT .............................................................................. 57

4.7 Synchronization ......................................................................................................................... 57
  4.7.1 Introduction ............................................................................................................ 57
  4.7.2 Who’s the Master? ..................................................................................................... 59
  4.7.3 Another Useful Tool for Synching ............................................................................. 62

5 Using the S2 with TRAKTOR DJ ................................................................................................. 65
  5.1 Key S2 Functions Using TRAKTOR DJ ............................................................................... 65
     5.1.1 Browsing & Loading Tracks ................................................................................. 66
     5.1.2 Deck Volume Controls and Crossfader .................................................................. 66
Table of Contents

7.7.1 GAIN/FILTER Encoder ................................................................. 118
7.7.2 EQ Knobs .................................................................................. 119
7.7.3 FX Assign Buttons ..................................................................... 120
7.7.4 Channel Fader and Channel Level Meter ................................. 121
7.7.5 Crossfader ............................................................................... 122
7.7.6 Main Section ............................................................................ 122
7.7.7 Headphones Cue Button ............................................................. 123
7.7.8 Master Display ......................................................................... 123
7.7.9 Browse Encoder (BROWSE) and Load Buttons (A and B) ........ 125
7.7.10 Remix Deck Knob and Mode Buttons (A and B) .................... 125
7.8 Using the FX Units ....................................................................... 126
7.8.1 Single Mode and Group Mode .................................................. 127
7.8.2 FX Unit Reference ..................................................................... 127
7.9 Browsing, and Loading ................................................................. 128
7.10 Native TRAKTOR Mode Vs. MIDI Mode ...................................... 130
7.10.1 Native Traktor Mode ................................................................. 130
7.10.2 MIDI Mode .............................................................................. 131
8 Customizing TRAKTOR KONTROL S2 ........................................... 132
8.1 The Preferences Window ............................................................... 132
8.2 Settings and Preferences for the S2 Control Elements .................. 134
8.2.1 S2 Control Options ................................................................. 136
8.2.2 Restore Default ....................................................................... 138
8.2.3 Calibration .............................................................................. 139
8.2.4 LEDs ...................................................................................... 140
8.3 Other Settings of Interest ............................................................. 140
8.3.1 Switching the Deck Flavors ..................................................... 140
8.3.2 Adjusting the Input Routing ..................................................... 141
8.4 The Setup Wizard ....................................................................... 141
# Table of Contents

## 9 The S2 Audio Interface and Control Panel
- **9.1** Settings on Mac OS X ......................................................................................................................... 144
- **9.2** Settings on Windows: The Control Panel ................................................................................................. 145
  - **9.2.1** Opening the Control Panel ............................................................................................................... 145
  - **9.2.2** Audio Settings Page ......................................................................................................................... 146
  - **9.2.3** Diagnostics Page ............................................................................................................................. 148
- **9.3** Using the S2 as your Default Audio Output Interface .................................................................................. 150
  - **9.3.1** Windows ........................................................................................................................................... 150
  - **9.3.2** Mac OS X .......................................................................................................................................... 150

## 10 Troubleshooting and Help
- **10.1** TRAKTOR Won’t Start .......................................................................................................................... 152
- **10.2** Hardware-related Problems .................................................................................................................. 152
  - **10.2.1** Basics ............................................................................................................................................... 152
  - **10.2.2** USB and Driver Issues .................................................................................................................. 153
  - **10.2.3** Updating the Driver ...................................................................................................................... 153
  - **10.2.4** USB-related Power Issues .............................................................................................................. 153
  - **10.2.5** Using the TRAKTOR KONTROL S2 with a Laptop .......................................................................... 154
- **10.3** Loose Jog Wheel Top Plate ................................................................................................................... 155
- **10.4** TRAKTOR Crashes ............................................................................................................................... 155
- **10.5** Getting Help .......................................................................................................................................... 156
  - **10.5.1** Knowledge Base / Readme / Online Support ................................................................................... 156
  - **10.5.2** Forum ............................................................................................................................................... 157
- **10.6** Updates ................................................................................................................................................ 157

## 11 Appendix A – Common Setups
- **11.1** TRAKTOR KONTROL S2 Basic Setup .................................................................................................... 158
- **11.2** Adding a Microphone .......................................................................................................................... 166

## 12 Appendix B – Technical Information
- **12.1** Technical Specifications ...................................................................................................................... 167
1 Welcome to the World of TRAKTOR KONTROL S2!

On behalf of the whole Native Instruments team, we are delighted that you have chosen TRAKTOR KONTROL S2 as your DJ controller!

1.1 What Is TRAKTOR KONTROL S2?

TRAKTOR KONTROL S2 is a fully integrated hardware and software DJ performance system created by the makers of TRAKTOR. TRAKTOR KONTROL S2 fuses the full-featured TRAKTOR KONTROL S2 hardware controller with the state-of-the-art TRAKTOR PRO 2 software.

The all-in-one TRAKTOR KONTROL S2 controller offers you an ergonomic DJ mixer, a built-in 24-bit/96 kHz audio interface, and a high-resolution control surface, perfectly tailored for TRAKTOR PRO 2. All controls needed for live performances now are at your fingertips!

Document Conventions

This document uses particular formatting to point out special facts and to warn you of potential issues. The icons introducing the following notes let you see what kind of information can be expected:

Whenever this exclamation mark icon appears, you should read the corresponding note carefully and follow the instructions and hints given there if applicable.

This light bulb icon indicates that a note contains useful extra information. This information may often help you to solve a task more efficiently, but does not necessarily apply to the setup or operating system you are using; however, it's always worth a look.

Furthermore, the following formatting is used:

- Text appearing in (drop-down) menus (such as Open..., Save as... etc.) and paths to locations on your hard drive or other storage devices is printed in italics.

- Text appearing elsewhere on the screen (labels of buttons, controls, text next to checkboxes etc.) is printed in light blue. Whenever you see this formatting applied, you will find the same text appearing on the screen.

- Important names and concepts are printed in bold.
References to keys on your computer's keyboard you'll find put in square brackets (e.g., "Press [Shift] + [Return]").

► Single instructions are introduced by this play button type arrow.

→ Results of actions are introduced by this smaller arrow.

1.2 The TRAKTOR KONTROL S2 Documentation at a Glance

1.2.1 Which Documents Are There?

The Setup Guide

A Setup Guide is available on the product registration page. Find a link to the registration page on the registration flyer, which is included in your TRAKTOR KONTROL S2 product box. It will guide you through the software and hardware installation of your TRAKTOR KONTROL S2 system, from the very beginning to the first sound coming through your speakers. This should be your first stop in learning TRAKTOR KONTROL S2.

First read the Setup Guide. Then proceed with this TRAKTOR KONTROL S2 Manual to get more familiar with TRAKTOR KONTROL S2!

The TRAKTOR KONTROL S2 Manual

After having read the Setup Guide and followed its instructions, your TRAKTOR KONTROL S2 system should be up and running. The next step is to read this document, the TRAKTOR KONTROL S2 Manual. The Manual first gives you a practical approach to TRAKTOR KONTROL S2. Then, it provides you with a detailed reference of your TRAKTOR KONTROL S2 hardware controller in the hardware reference chapter, and task oriented information in the task reference chapter. Section ▲1.2.3, In This Manual will give you an overview of the manual content.

The TRAKTOR 2 Manual

For in-depth information on all features provided by the TRAKTOR software, please refer to the TRAKTOR 2 Manual. It is available as a PDF file in the Documentation subfolder of the TRAKTOR 2 installation folder.
1.2.2  Recommended Reading Order

We advise reading the documents in the following order:

1. The Setup Guide.
2. The TRAKTOR KONTROL S2 Manual.

1.2.3  In This Manual

What you are reading now is the TRAKTOR KONTROL S2 Manual. This manual is structured as follows:

▪ Chapter ↑2, TRAKTOR KONTROL S2 Quick Overview quickly introduces you to the TRAKTOR KONTROL S2 user interface and its main areas, both on the hardware side and software side.

▪ Chapter ↑3, Preparing Your Music Library shows you how to import your own music into the powerful Track Collection of TRAKTOR, so that you can use all TRAKTOR KONTROL S2 features with your own tracks.

▪ Chapter ↑4, Tutorials is a selection of tutorials focused on your controller. They will let you progressively discover how to use the various tools provided by TRAKTOR KONTROL S2. These practical examples will simplify the learning process and get you quickly started with computer-based DJing.

▪ Chapter ↑5, Using the S2 with TRAKTOR DJ is a concise overview of using the TRAKTOR KONTROL S2 with TRAKTOR DJ on an iOS device.

▪ Chapter ↑6, Hardware Overview is an extensive reference of all hardware control elements to be found on your TRAKTOR KONTROL S2 hardware controller. Whenever you are unsure about the functionality of a particular control element, you will find all the necessary information here.

▪ Chapter ↑7, Hardware Control Reference is a collection of mini tutorials, showing you how to work with the individual areas of the controller, e.g., you'll find a subchapter explaining what you can do with the Mixer section, and how you can do it.

▪ Chapter ↑8, Customizing TRAKTOR KONTROL S2 shows you how to customize TRAKTOR KONTROL S2 in order to make it fit your particular needs.
• Chapter ↑9, The S2 Audio Interface and Control Panel describes the on-board audio interface of the TRAKTOR KONTROL S2 hardware controller.

• Chapter ↑10, Troubleshooting and Help provides you with a list of most common problems and their solutions, along with info on how to get help.

• Finally, three appendixes provide you with additional information:

  ◦ Appendix A shows you how to integrate TRAKTOR KONTROL S2 with your studio or live setup in various configurations.

  ◦ Appendix B gives you the technical specifications of the TRAKTOR KONTROL S2 controller.

  ◦ Appendix C provides you with quick reference tables for all control elements on your controller. Should you have any doubt about a particular control element, you will find a useful reminder here!

**Pet Names for Software and Hardware**

Throughout the documentation, we will refer to the TRAKTOR KONTROL S2 hardware controller whether as “TRAKTOR KONTROL S2,” "S2 controller," or simply “S2.”

Likewise, the TRAKTOR software will sometimes be referred to as “TRAKTOR.”

Hence, a sentence like “TRAKTOR KONTROL S2 is a highly integrated DJ system allowing you to control TRAKTOR from your S2” shouldn’t sound weird to you.

### 1.3 System Requirements

For the minimum system requirements your computer needs to meet, see the TRAKTOR specifications section of the Native Instruments website:


To check the compatibility with several operating systems, please have a look at: http://www.native-instruments.com/compatibility
This mini-chapter will quickly introduce you to TRAKTOR KONTROL S2’s main areas and concepts both on your TRAKTOR KONTROL S2 hardware controller and in the TRAKTOR PRO software.

To start off with, there are four virtual Decks in the TRAKTOR PRO software, and each of them can be operated in several modes: Track Deck mode, Remix Deck mode, and Live Input mode, so you have a very flexible system on your hands. However, in combination with the TRAKTOR KONTROL S2 controller, the software's upper Decks should always be Track Decks, whereas the software's lower Decks should always be Remix Decks. Setting up your S2 controller and the TRAKTOR software with the Setup Guide, this is how your software will initially be configured. Keep this in mind throughout the rest of this manual.

Take the time to read these few pages, as they will familiarize you with the way TRAKTOR KONTROL S2 works and let you catch sight of the power of its design. If you're familiar with importing music files in TRAKTOR, you can skip chapter ↑3, Preparing Your Music Library and start with the tutorials in chapter ↑4, Tutorials (after having read this chapter).
(1) **Decks:** TRAKTOR KONTROL S2 provides you with two physical Decks. The Decks are the place where tracks (and Samples) are controlled. They can be seen as the equivalent to the good old vinyl or CD decks, but with a bunch of additional features and the flexibility of a computer-based system connected to them. The **left Deck** on your S2 controls Track Deck A in the software. The **right Deck** on your S2 controls Track Deck B in the software. Additionally, you can gain control over TRAKTOR's Remix Decks C and D with the controller's CUE/REMIX SLOTS section. For that, the CUE/REMIX SLOTS section needs to be switched to Remix Deck.
mode (as opposed to Cue mode, where the buttons control the Cue Points in Track Deck A and B). For more information on the two modes, please refer to section 7.5, Using the CUE/RE-MIX SLOTS Section.

(2) **FX Units**: The signals coming from the Decks can be processed by two FX Units, located at the top of both your hardware and software interface. The FX Units give you access to the whole collection of high-quality FX included in TRAKTOR: The left FX Unit on your S2 controls the left FX Unit in the software, which processes Track Deck A in TRAKTOR. The right FX Unit on your S2 controls the right FX Unit in the software, and processes Track Deck B in TRAKTOR.

To be honest, you can assign the FX Units to process whichever source you want (Decks A-D); however, as for the introduction, let's keep things simple.

You can also activate two additional FX Units in the software, allowing you to process Remix Decks C and D in TRAKTOR, or even to send a Deck of your choice through numerous FX units. The TRAKTOR architecture is very flexible when it comes to the use of the virtual Decks and effect routing. See the TRAKTOR 2 Manual for further information.

(3) **Mixer**: Sitting in the middle of your TRAKTOR KONTROL S2 controller, the Mixer receives the audio signals coming from all TRAKTOR software Decks A-D; there is one channel for each Track Deck A and B, and one combined channel, controlling both Remix Decks C and D, so basically you have a three-channel mixer. As any DJ mixer, the Mixer’s purpose basically is to: adjust the relative level of each channel; to control the channels’ frequency content; possibly to feed them into FX Units; and to send the overall result to the Main section at the top of the Mixer section. In the end, this is the mix that is sent to your audience.

You will find a more detailed presentation at the beginning of chapter 6, Hardware Overview, followed by a thorough description of each control element to be found on your TRAKTOR KONTROL S2 controller. For an in-depth explanation of each and every functionality provided by the TRAKTOR software, please refer to the separate TRAKTOR 2 Manual, provided on the installation disc.
Preparing Your Music Library

Most likely, you already have a collection of music files on your computer. For those of you who can’t wait for mixing their own tracks, this chapter is for you! You will learn here how to quickly import your music into the powerful Track Collection of TRAKTOR.

If you prefer to start learning how to use TRAKTOR KONTROL S2 right away, skip this chapter and go on with the tutorials in chapter ↑4, Tutorials, which make use of the demo tracks provided with TRAKTOR KONTROL S2. You can always come back here at a later point.

3.1 What Is the Track Collection?

The Track Collection (or simply “Collection”) represents the whole music that you have in your TRAKTOR database.

Based on the music files on your computer, the Track Collection is just another way to display these files. The Collection makes it easy to organize, tag, and prepare your tracks for being integrated into your mix.

Worth to note is that the Track Collection doesn’t care about the actual file structure on your hard disk, nor will it alter this structure in any way (as long as you don’t delete your files from within TRAKTOR).

What the Track Collection is

▪ A database storing numerous information about your music files.

▪ A convenient way to represent and search your music files, according to many of their characteristics (tags) like title, artist name, BPM, genre, length, etc.

▪ The place where TRAKTOR-specific information about your tracks is stored.

▪ The basis on which you can create your Playlists.

What the Track Collection isn't

▪ Moving, copying nor converting any audio file to some secret location.

▪ Modifying in any way the hierarchic structure of your files on your hard disk.
To make use of the Track Collection, you have to populate it by importing your music files.

### 3.2 Importing Music Folders

TRAKTOR offers an easy import function for tracks stored on your hard drive:

- Right-click (Windows) or [Ctrl]+click (Mac OS X) on the Track Collection entry in the Browser Tree and choose *Import Music Folders* from the menu.

By default, this process imports all music files contained in the *My Music* folder of your operating system.

Be sure to prepare the tracks you want to use in a DJ set beforehand if you want to use features such as synching or Auto Looping with them: TRAKTOR analyzes music for certain characteristics (BPM, etc.). This is done by right-clicking on one or more selected tracks in the Browser and then choose the option Analyze (Async) from the Right-click menu. Another quick way to analyze a track is to simply drag it into a Track Deck. A light blue bar at the bottom of TRAKTOR moving to the right indicates the analyzing progress.
If you have stored tracks in other folders or on external storage devices, you can add these folders to the list of TRAKTOR Music Folders as follows:

1. Open Preferences > File Management.
2. Click Add... at the bottom of the Music Folders section.
3. Navigate to a folder you want to add.
4. Confirm with OK.

Repeat to add all of your Music Folders.

Subfolders are automatically included in the scan. Hence, you don’t need to add them to this list.

### 3.3 Tracks Managed by iTunes

If you have organized your music collection with iTunes, TRAKTOR offers direct access to your iTunes Library and your iTunes playlists.

#### 3.3.1 Playing Tracks Managed by iTunes

You can browse your iTunes Library and playlists directly from your TRAKTOR KONTROL S2. By the way, this will be the opportunity to introduce you to browsing and loading from your hardware controller. For this, we will use the following control elements:

- The **SHIFT** button:

![SHIFT Button](image)

- The **BROWSE** encoder:

![BROWSE Encoder](image)
To browse for tracks and add them to the Decks:

1. Press and hold **SHIFT** (no matter which one) and turn the **BROWSE** encoder to scroll through the Browser Tree until the **iTunes** icon gets selected. Then, while still keeping **SHIFT** pressed, push the **BROWSE** encoder to open the iTunes node.
2. Scroll to a playlist within that node in the same manner.
3. Once the desired playlist is selected in the Browser Tree, release the **SHIFT** button.
4. Turn the **BROWSE** encoder to browse through the iTunes playlist selected in the previous step, until you find a track worth playing.
5. To load a track into the left Deck (which controls TRAKTOR's Track Deck A), press **LOAD button A** below the **BROWSE** encoder.
6. Repeat steps 4-5, but at the end press **LOAD button B** to load the track to the right Deck (which controls TRAKTOR's Track Deck B).

The iTunes tree node represents a read-only view on your iTunes Library and playlists. Editing functions are not available in this view.

**Software Equivalent**

Of course, you can do all this from the TRAKTOR software user interface too:

1. Click the **iTunes** icon in the Browser Tree to open that node.
2. Browse through the Library and playlists as you would do in iTunes.
3. Load a track into a Deck as you would do from a normal TRAKTOR Playlist — for example by dragging the track onto that Deck.

**3.3.2 Importing a Selection of Tracks from iTunes**

You can import a selection of tracks from your iTunes Library into the Track Collection via the TRAKTOR user interface:

1. Click the **iTunes** icon in the Browser Tree to open that node.
2. Select the tracks to import into the Track Collection.
3. Drag the selection onto the **Track Collection** icon in the Browser Tree.
4. Alternatively, right-click (Windows) or [Ctrl]-click (Mac OS X) on the selection and choose *Import to Collection* in the contextual menu.

### 3.3.3 Importing iTunes Playlists

You can directly import iTunes playlists as TRAKTOR Playlists via the TRAKTOR user interface:

1. Click the **iTunes** icon in the Browser Tree to open that node.
2. Select the playlist to be imported.
3. Drag the playlist onto the **Playlists** icon.

► Alternatively right-click (Windows) or [Ctrl]-click (Mac OS X) on the playlist and choose *Import to Playlists* in the contextual menu.
4  Tutorials

This chapter will guide you through the most common tasks that you will encounter during your work with TRAKTOR KONTROL S2.

The tutorials are workflow-oriented. They start with the simplest tasks and progressively lead you to more complex operation, helping you to get more and more familiar with your TRAKTOR KONTROL S2 system. After reading this, you should have the basic know-how, allowing you to mix with TRAKTOR KONTROL S2.

The tutorials presented here and in the following chapter make use of the included demo tracks, which were copied to your hard disk during the TRAKTOR KONTROL S2 installation procedure. Thus, you can follow these tutorials even if you haven’t imported your own music yet into the Track Collection. For more info on how to import your music into the Collection, please refer to chapter 3, Preparing Your Music Library.

Keep in mind: The left Deck on the controller corresponds to TRAKTOR’s Track Deck A, while the right Deck corresponds to TRAKTOR’s Track Deck B.

4.1  Playing Your First Track

This first tutorial will show you how to load and play a track, how to check the needed audio outputs, and how to quickly troubleshoot your system if no music can be heard.

Prerequisites

We assume here that your TRAKTOR KONTROL S2 system is already up and running. If it’s not the case, please follow the instructions in the separate Setup Guide and come back here when you’re done!

In case you already changed some settings in TRAKTOR before you start with these tutorials, we strongly recommend you to reset your system to the initial settings by doing the following:

1. In the TRAKTOR software, click the Help menu in the menu bar at the top of your screen (on Mac OS X) or at the top of the window (on Windows), and select Help > Start Setup Wizard.
2. In the window that opens, click Next to confirm your S2 is connected.
3. The next window asks you whether you want to use an external mixer with TRAKTOR. Select Yes, as you will be using the controller's mixer for mixing with TRAKTOR.
4. The next window asks what combination of Deck Flavors you would like to use in TRAKTOR. Select 2 Track Decks + 2 Remix Decks from the drop-down menu, and click Next.
5. Click Finish to confirm your selection and close the Setup Wizard.

→ TRAKTOR is now optimized for use with your S2 controller.

One more thing: Using an external mixer, TRAKTOR assumes you do not want to see the software mixer on the user interface. But we do want to see what's happening in the software's mixer when controlling it from the S2. So what we need to do now is change TRAKTOR's interface appearance with the Layout selection drop-down menu in the following way:

► Click on the drop-down menu next to the magnifying glass symbol in TRAKTOR's Header and select Mixer from the list.

→ You can now see TRAKTOR's mixer in the middle of the user interface.

4.1.1 Quick-Loading a Track

Let’s load the track “Techno 1” from the included demo tracks on to Deck A. To select and load the track, we will use these control elements on your S2:

- Any of the two SHIFT buttons (one at the bottom of each Deck):
The **BROWSE** encoder (in the center of the Mixer):

![BROWSE Encoder](image)

The left Deck’s **LOAD** button (labeled "A" below the **BROWSE** encoder):

![LOAD Button](image)

While looking at the TRAKTOR software window, do the following:

1. **Hold** **SHIFT** and turn the **BROWSE** encoder to select the **Playlists folder** from the Browser Tree. While keeping **SHIFT** depressed, press the **BROWSE** encoder button to expand the folder node.
2. **Hold** **SHIFT** and turn the **BROWSE** encoder to select the **Demo Tracks Playlist**

   The tracks of the **Demo Tracks Playlist** appear below (in case you can't find the **Demo Tracks Playlist** here, you can also open it from the Browser Tree's **Explorer node**):

   ![Demo Tracks Playlist](image)

3. **Release** **SHIFT** and turn the **BROWSE** encoder to scroll through the Playlist and navigate to the track **Techno 1**.
4. Once the track is highlighted, press the LOAD button A on the controller to load that track on to Track Deck A. (Obviously, to load the track to Track Deck B, you would have to press LOAD button B on the controller.)

→ The track is loaded. In TRAKTOR, its waveform and info appear on Deck A:

In addition to using the S2 to load a track, you can also drag and drop tracks from the Browser or from a folder on your computer directly into one of TRAKTOR’s Decks.

4.1.2 Playing the Track

► Once the track is loaded, simply press the PLAY button on the left Deck:

→ The track starts playing. The PLAY button lights up and the waveform starts moving in TRAKTOR.

Again, pressing the PLAY button on the right Deck would have started the playback on Track Deck B.
To Each Deck Its Own Channel

The audio playing on each Deck can be further shaped by the controls on the corresponding channel of the Mixer. Since the track is loaded on Deck A, you can control its sound on channel A (the left Mixer channel):

At this point you will probably hear some audio coming through your speakers or PA. If not, please check the following section.

4.1.3  If You Don’t Hear the Track

If the track is playing on the Deck but the audio coming through your amplification system sounds too low, or if there is no sound at all, check the following:
► At the bottom of your S2, verify that the crossfader is moved all the way to the left:

![Crossfader Image]

► Above, the channel fader of channel A should be raised to its highest:

![Channel Fader Image]

► The Level meter of Channel A should show some activity. If not, check that the HI, MID, LOW on the left channel are set to center position; and at the top of the channel, push the GAIN/FILTER encoder once to reset the channel’s input gain to 0 dB.

![Level Meter Image]

► At the top center of the Mixer, the MAIN LEVEL knob should be turned at least part of the way to the right:

![Main Level Knob Image]
If you see some activity on the S2's **MAIN LEVEL** meters, or on TRAKTOR'S **MAIN** level meters in the software's Header but don’t hear any sound, then double-check the connection starting with the cable going from the S2’s main outputs to your PA.

### 4.2  Mixing In a Second Track

Now that you have learned how to quickly load and play tracks using the TRAKTOR KONTROL S2 (see chapter ↑4.1, Playing Your First Track), let’s see how to mix in a second track. On the way, you will learn a few basic mixing tasks that every digital DJ needs to know: how to pre-listen to tracks, how to synchronize tracks, how to start the playback at the right position, and how to mix the tracks together using the crossfader.

**Prerequisites**

We assume here that you already followed the instructions in the previous tutorial (see chapter ↑4.1, Playing Your First Track). TRAKTOR KONTROL S2 now is in the following state:

- The track “Techno 1” is loaded on Deck A. The track is playing and audible.
- The crossfader is all the way to the left.

#### 4.2.1  Loading and Playing the Second Track

We will choose the track “Techno 2” and load it on Deck B, as we did on Deck A in the previous tutorial:

1. Navigate to track Techno 2 in the Demo Tracks Playlist.
2. Press the LOAD button B to load the track on to Deck B.
   
   In the TRAKTOR window, the track info and waveform appear on Deck B.
3. Press the **PLAY** button on the controller's right Deck to start the playback.

→ The track starts playing. The **PLAY** button lights up and the waveform starts moving on TRAKTOR’s Deck B.

We don’t hear anything from Deck B through the speakers yet because we have set the crossfader on the S2 all the way to the left — our plan is to slowly mix in the track on Deck B.

Before we go on, we have to turn up the **CUE MIX** knob on the front panel of the S2 to its middle position.
You can already give it a try: by slowly moving the crossfader to the right, you should hear the track on Deck B fade in, whereas the track on Deck A progressively fades out as you move the crossfader further to the right. Obviously, our mix is not satisfying at all yet: before mixing in the second track, we first have to beat-match it to the track playing on Deck A. So for now, pull the crossfader all the way back to the left.

If you don’t hear any sound coming from Deck B even with the crossfader all the way to the right, check the few troubleshooting guidelines in section 4.1.3, If You Don’t Hear the Track.

4.2.2 Using Headphones to Prepare the Mix

From now on, let’s get used to preparing our mix with headphones until the next track (here on Deck B) is ready to be mixed in.

The CUE button

► On your S2, press the CUE button on channel B (the one above the fader).

→ The button lights up, indicating that Deck B is now sent to the Cue channel, which you will hear in your headphones.

At any time, use the CUE MIX knob at the front panel of your S2 to adjust the balance between the cued track (Deck B) and the main mix (Deck A) in your headphones: turn it counterclockwise when you want to concentrate on the cued track; turn it clockwise when you want to hear more of the main mix.

You are now ready to work on the track playing on Deck B without interfering with the main mix sent to your audience. Regardless of the mix that you’re hearing in your headphones, the main mix is still controlled by the crossfader and channel faders.

4.2.3 Synchronizing the Second Track

Before mixing in the track playing on Deck B, we will use TRAKTOR’s automatic Sync feature to adjust its tempo to that of Deck A. This is done in just one step via the SYNC button:
Press the **SYNC** button on the right Deck to synchronize its tempo and phase with those of Deck A.

The **SYNC** button lights up. Now the two tracks are in perfect sync.

By slowly turning the **CUE MIX** knob on the front panel, you will hear the second track come into the mix in sync with Deck A.

Note that you should always adjust the tempo of the track that is *not* audible to the audience!

### 4.2.4 Setting a Cue Point as Starting Point

You will probably want to have more control over which particular part of the track you mix in. For example, most of the time, not only the tempos but also the downbeats of both tracks should match. Using a particular point in a track (for mixing in, triggering, etc.) is called “cueing.”

TRAKTOR KONTROL S2 lets you mark points for cueing — we call them Cue Points. This notably allows you to re-use these points at a later stage, or in a later session.

On the right Deck, whether or not the track is playing, simply press one of the unlit **CUE/REMIX SLOTS** buttons 1-4 on a downbeat — let’s say the **CUE/REMIX SLOTS** button 1.

The button lights up in blue: you’ve just stored a Cue Point that you can return to, simply by pressing the same button again.
**Snapping Cue Points to Beats**

You don’t have to worry about dropping a Cue Point directly on a beat using TRAKTOR's Snap function. With Snap mode on, any Cue Point you set in the track will snap to the closest beat, thus ensuring that you get directly to that beat next time that you jump to that point. To activate Snap mode, press the **S** button below the **MAIN** knob in TRAKTOR's Mixer. (If the Mixer is not visible, you can select to display the mixer from the drop-down menu on the upper left side of the user interface. It's the menu to the left of the magnifying glass symbol.)

![Snap mode indicator button (S) in TRAKTOR's Master panel.](image)

**Aligning the Tracks**

Aligning both tracks is straightforward:

1. Make sure that Deck B is playing (its **PLAY** button must be lit).
2. When you hear a downbeat in the other track, press the **CUE/REMIX SLOTS** button you just used to store the downbeat position to.

→ The playback position on Deck B jumps to the stored Cue Point (as you can see in the TRAKTOR window), and the playback continues from there. Both tracks now are perfectly aligned, ready to be mixed.

**Sticking to the Beats**

Again, you don’t have to worry about pressing the button exactly on the beat: by default, TRAKTOR will make sure that the beats of both tracks stick together and that the jump doesn’t ruin the beat matching. This is because the so-called Quantize mode is on, as you can see by the lit **QUANT** button (**Q**) on the Master panel (see picture below).

With Quantize mode on, whenever you jump through the track (e.g., by pressing a **CUE/REMIX SLOTS** button), the playback jumps to the nearest position that preserves the beat matching, thus ensuring that the current sync doesn’t get lost when you jump through the track.
The Snap mode indicator and the Quantize mode indicator buttons both lit in TRAKTOR’s Master panel.

### 4.2.5 Interlude: In Case the Left Track Has Reached Its End

The track “Techno 1” on Deck A has been playing since we started with the tutorials, and it might happen that the playback reaches the end of the track. In this case, just do the following:

- On the left Deck, press **SHIFT+CUE** to skip back to the beginning of the track.

You can then resume from where you left off.

### 4.2.6 Mixing In the Track by Using the Channel EQ and Filter

Now would be a great time to audition some of TRAKTOR KONTROL S2’s EQs and filters:

- Turn any of the EQ knobs on channel B to hear the effect on the cued track.

The EQs are excellent tools for making adjustments to tracks before mixing them in so that you get the smoothest transition possible. The most common technique is to filter the bassline out of the incoming track — having two basslines running rarely sounds good.
We will now carry out a first real track blend. Thus, turn the CUE MIX knob fully clockwise to hear the main mix in your headphones (or put off your phones and listen to your mix coming through your amplification system).

To mix in the track:

1. With the crossfader still on the left, turn down the LOW knob on channel B to take the bass out of the track on Deck B.
2. Progressively mix in channel B by gradually moving the crossfader from the left to the center position.
3. When both tracks are running together and you want to bring the bass back in, gradually decrease the bass amount of channel A while simultaneously increasing that of channel B.
4. Complete the transition by gradually moving the crossfader all the way to the right.

→ You just did your first mix with TRAKTOR KONTROL S2!

4.2.7 Doing Everything by Hand

You can also do your mix manually instead of using TRAKTOR’s sync and cueing facilities.

Most probably, you won’t do everything by hand in your everyday DJ work. Nevertheless, it is a good idea to get familiar with the “handcrafted” way because:

▪ It can be necessary when synching to a playing vinyl record or to the previous DJ.
▪ You can combine it with TRAKTOR’s advanced features, thus further developing your own mixing style.

To show this, let’s mix a new track on Deck A with the one we just mixed in on Deck B.

From now on, the track on Deck B is “on air,” i.e. it is heard by your audience. Hence, we will now exclusively work on the controller’s left Deck, which controls Track Deck A in the software.

First Steps

1. First check that the crossfader is at full right.
2. With the track on Deck B still playing, load the track House 1 from the Demo Tracks Playlist onto Deck A (reminder: turn the BROWSE encoder to select the track in the list, then press the LOAD button A for Deck A).
3. Press **PLAY** on the left Deck to start the playback of the new track.
4. On the same Deck, make sure the **SYNC** button is not lit.
5. On the Mixer, deactivate the **CUE** button above channel B’s fader and activate that of channel A to hear the new track in the headphone mix (you might need to adjust the **CUE MIX** knob accordingly).

### Adjusting the Tempo

The tempo for each Deck can be manually controlled via the **TEMPO** fader:

![TEMPO fader](image)

Use the TEMPO fader to adjust the Deck’s tempo.

► Adjust the tempo fader on the left Deck until the track’s BPM either “sounds right,” or directly matches the value of the other track’s BPM, which is displayed at the top of Track Deck B in TRAKTOR.

### Manually Cueing with the Jog Wheel

You can use the jog wheel to manually seek through the track and find a nice bring-in point:
The left jog wheel on your S2 controller.

1. On the left Deck, press and spin the jog wheel’s top plate to seek through the track. (You can also fast seek through the track by holding the SHIFT button at the bottom of the Deck while spinning the jog wheel.)

2. Once you have found an interesting point for cueing (let’s say a downbeat), keep pressing the top plate and release it when a downbeat arrives in the other track. Deck A starts playing from that point.

Note that you could also stop playback (by pressing the PLAY button) before you seek an interesting point with the jog wheel. Once you have found the point, you can then release the jog wheel — since the Deck is not playing, the playhead will stay put at that position. When a downbeat arrives in the other track, press PLAY again on the left Deck.

**Aligning the Beats**

In case you still hear a slight offset between both tracks, you can use the outer rim of the jog wheel to adjust the track’s phase and cancel the offset:

- On the left Deck, move the jog wheel’s outer rim in the desired direction to temporarily bend the tempo and adjust the phase in order to cancel any minor offset.

→ Your tracks now perfectly match.
Mixing In the New Track

► When you’re ready, you can bring the crossfader over from Deck B and slowly mix in the track in Deck A.

→ You just did your first handmade mix with TRAKTOR KONTROL S2!

Don’t expect to be capable of manually matching beats right away. It requires intensive training and can’t be fully explained here in detail. Practice makes perfect!

4.3 Adjusting Levels

Before going any further, we would like you to be aware of how important it is to have your mix at the right level. We provide you here with a few simple hints in order to get the best sound out of your mix.

Even if this section might look a bit technical, please take the time to read these few pages, as they can save you a lot of trouble, especially in a live situation!

4.3.1 The Theory

By mixing, you blend together signals coming from different sources (and possibly process them on the way).

The basic rule is: you need to ensure that no signal is clipping, while simultaneously trying to use the full dynamic range available. Just to keep it short, there are two reasons behind this:

- By using the full dynamic range available, you keep the noise level low, relative to your mix that is. As a result, all the details of your music are better rendered.
When a signal is clipping, it is not getting louder, just worse. The loud parts (typically the beats) are cut, which both reduces the dynamic range and introduces distortion in your mix. The speakers will suffer from this — and so will your audience! (Be also prepared for some angered sound technician or club owner coming down on you.)

Hence, you should always make sure that your signals stay at levels that satisfy these two requirements.

### 4.3.2 The Practice

To assist you in adjusting levels, the Mixer of your S2 is equipped with various level meters and controls. Each level meter consists of a bar of blue LEDs indicating the signal level, along with an orange LED at the top indicating the clipping.

The LEVEL meters on the S2.

The rule mentioned above can thus be translated as follows:

- **Best practices when adjusting levels**: Ensure that the displayed levels go as high as possible in the blue areas without reaching the red LEDs, or only very rarely.

Letting your levels go “in the red” and using signal clipping to let your mix sound dirtier is definitely not recommended; to add filth or distortion, rather make use of the great FX selection of TRAKTOR instead!

### Checking the Level on Each Channel

Each channel on the Mixer provides you with a vertical channel level meter next to the fader. This meter shows you the pre-fader level of the signal on that channel, i.e. the absolute level of the signal before it is adjusted by the channel fader. To adjust this level, use the **GAIN/FILTER** encoder at the very top of the channel:
A GAIN/FILTER encoder sits at the top of each channel.

► Adjust the channel’s GAIN/FILTER encoder so that the level displayed on the channel meter stays in the upper part of the blue area without reaching the red clipping LED.

Note that the channel’s EQ and filter settings also affect the signal level, as well as the possible FX Unit(s) it is assigned to. Hence, when modifying any of these, you might need to readjust the GAIN/FILTER encoder accordingly.

Of course, the artistic side of your tracks should not be overlooked: for tracks with a variable average level over time (e.g., a track starting with a soft intro), you should consider the loudest parts of the track when adjusting the channel level.

**Matching Levels between Channels**

Moreover, in order to avoid any level jump when crossfading between two channels, the average channel levels should match:

► Before mixing in a cued channel, adjust its GAIN/FILTER encoder so that its channel meter activity roughly matches that of the channel currently on air.

**TRAKTOR** already does this for you by automatically setting the level for each newly loaded track to a satisfying value. This so-called “Autogain” feature relies on the gain values extracted from your tracks. Nevertheless, depending on the particular EQ, filter and FX applied to the cued track, you might have to double-check the level consistency before you mix in the track. Moreover, what is important here is the average level of the specific part of the track that you’re about to mix in.

**Checking the Main Level**

The signals coming from all channels are mixed together according to the relative levels set by the channel faders and by the crossfader. This mix is then sent from TRAKTOR’s main output to the Main section. Below you see a picture of the S2's MAIN LEVEL knob.
The MAIN section on your S2.

The MAIN level meters in the Header of TRAKTOR show you the (left and right) overall level of your mix before it is adjusted by the MAIN LEVEL knob. To adjust this level, use the MAIN knob right below the MAIN level meters in TRAKTOR’s Master panel (see below).

The MAIN meter and MAIN knob in TRAKTOR.

► Adjust the MAIN knob in TRAKTOR’s Master panel so that the values of the MAIN level meters stay in the upper part of the blue areas without reaching the red clipping LEDs.

By default, a limiter is enabled on TRAKTOR’s main output. With this limiter enabled, the MAIN level meters’ clipping LEDs don’t indicate clipping anymore, but instead they indicate when the limiter kicks in. While the limiter virtually cancels any distortion that might occur, the resulting contraction of the dynamic range, though, cannot be undone. Therefore, even with the limiter enabled, ensure that the clipping LEDs don’t light up too often!

When the red clipping LEDs light up, turning down the MAIN LEVEL knob on your S2 is of no use: indeed, changing the level of the already distorted or shrinked signal coming from TRAKTOR won’t repair it!

⚠ Turn down TRAKTOR’s MAIN knob if clipping or limiting occurs.

💡 Should the level stay low on the MAIN level meters, check also the channel faders—they are probably set too low as well!
4.4 Looping and Cueing

Now that you have learned the basic mixing tasks, we will focus on one of TRAKTOR KONTROL S2’s great features: its looping facilities.

Prerequisites

As always, we assume here that you already followed the instructions in the previous tutorials. TRAKTOR KONTROL S2 now is in the following state:

- The track “House 1” is loaded on Deck A. The track is playing and audible.
- The crossfader is all the way to the left.

4.4.1 Playing with Loops

On your S2, each Deck is equipped with dedicated loop controls, located in the LOOP section, right under the jog wheel:

Setting a Loop with a Predefined Size

Let’s add a Loop to the track on Deck A.

To engage a loop on a playing track, just push down the LOOP SIZE encoder.
This will automatically add a loop at that position in the track. The Loop size will correspond to the number on the Loop section in TRAKTOR:

The Loop Size Display.

To change the size of the Loop, just turn the same LOOP SIZE encoder until the display reads the number of beats you’d like the Loop to be.

Note that you can adjust the Loop size either before or after you’ve set the Loop! When doing it beforehand, it will affect the next Loops you set.

**Setting a Loop Manually**

You can also manually set loop start and loop end points. To do this, use the LOOP IN and LOOP OUT buttons in the Loop section:

1. Press the LOOP IN button to set the Loop In Point.
2. Press the LOOP OUT button to set the Loop Out Point.

As soon as you hit the LOOP OUT button, a Loop is set and the track will start looping.

We already introduced the Snap mode in the previous tutorial (see ↑4.2.4, Setting a Cue Point as Starting Point). This mode also affects the Loop In and Loop Out Points, so that they will automatically be positioned directly on the beat.

Of course, you can also change the size of manually set Loops via the LOOP SIZE encoder as described above.

When setting a Loop manually, the Loop size displayed in TRAKTOR’s Loop section might not always match the actual Loop size.
Moving a Loop

You can also quickly move the active Loop across your track by using the LOOP MOVE encoder, at the left of the Loop section:

To move the Loop, turn the LOOP MOVE encoder.

The size of the move also corresponds to the Loop size that is currently set, as displayed in TRAKTOR’s Loop section.

Turning the LOOP MOVE encoder when there is no Loop currently active lets you jump backward/forward through the track by the same Loop size. See section 7.3.2, Tempo Reset for more info.

Storing a Loop

In the previous tutorial, we looked at how to store Cue Points. This is as simple as pressing an unlit CUE/REMIX SLOTS button.

Storing Loops works similar:

To store the active Loop, press an unlit CUE/REMIX SLOTS button.

The CUE/REMIX SLOTS button lights up, this time in green: you’ve just stored a Loop that you can return to simply by pressing the same button again.

The same button lit in green.
Deactivating Looping

If you want to deactivate the current Loop, do the following:

► To deactivate looping, push either of the LOOP MOVE or LOOP SIZE encoder.

→ The playback continues after the Loop.

By pushing the LOOP MOVE encoder when there is no Loop currently active, you activate looping: the next Loop in the track will be activated.

4.4.2 Using Hotcues

In this tutorial and in the previous one, we already used Hotcues to store Cue Points and Loops. We want to show you here a few more details on their use.

As already explained, when pressing an unlit CUE/REMIX SLOTS button when there is no Loop active, you store a Cue Point at the current playback position (the button turns blue). In case there is a Loop active, you store this Loop (the button turns green).

On the waveform of the software Deck, you can see that a line with the same color appears in the track at the corresponding position. Moreover, a little number at the top reminds you which button you should use to jump to that Cue Point or Loop:

A waveform with a Cue Point stored as Hotcue 2 and a Loop stored as Hotcue 3.

If you make a mistake, or just decide you no longer want a particular Hotcue, you can quickly clear it:
To clear a Hotcue, hold down the **SHIFT** button and press the corresponding **CUE/REMIX SLOTS** button.

You can see that the button is no longer lit.

**Example**

Hotcues aren’t just bookmarks to particular sections of a track — they can also be used for creative techniques such as remixing parts of a song, beat juggling effects, etc.

As an example, we will show you here how you can quickly make use of a Loop stored in a Hotcue slot to introduce the track you’re about to mix in. By the way, this will allow us to sum up what we’ve learned until now.

Provided that you carefully followed the instructions in the previous tutorials, the track “Techno 2” is still loaded on Deck B. Let’s say that the track on Deck A is on air (crossfader at full left) and you want to prepare the track on Deck B for mixing in:

1. Start the playback of the next track and send it to your headphones by activating the **CUE** button on the corresponding channel in the center of your S2.
2. Find an interesting Loop near the beginning of the track by using the controls in the Loop section of the right Deck.
3. Once you have a nice Loop running, store it by pressing an unlit **CUE/REMIX SLOTS** button and leave it playing.
4. Now start to bring this Loop in your mix, for example by implementing the low cut we explained in the previous tutorial (see ↑4.2.6, Mixing In the Track by Using the Channel EQ and Filter).
5. When you’re about to fade out the previous track completely, release the Loop on the new track, and you’re done.
4.5 Using Samples in Your Mix

As previously mentioned, the TRAKTOR software provides you with four virtual Decks, each of which can be operated in several modes: Track Deck mode, Remix Deck mode, and Live Input mode. The left and the right physical Deck on your S2 controller generally control the upper Decks A and B in the TRAKTOR software. In combination with the S2, these Decks should always be in Track Deck mode. Additionally, the S2 provides functionality for controlling the software's lower Decks C and D with the CUE/REMIX SLOTS sections. In combination with the S2, these Decks should always be in Remix Deck mode. Setting up your S2 controller and the TRAKTOR software with the separate Setup Guide, this is how your software will be configured.

To control TRAKTOR's Remix Decks C and D with your S2, you need to switch the CUE/REMIX SLOTS sections to Remix Deck mode. This is done with the A/B buttons below the REMIX knob.

The REMIX knob controls the volume of both Remix Decks together, it's a combined channel. Once you switch the CUE/REMIX SLOTS sections to Remix Deck mode, the buttons 1 to 4 control the upper Sample Slots of Remix Decks C and D, instead of the Track Decks' Cue Points.
Remix Decks are a great way to add Samples to your set, or capture Samples for on-the-fly remixing. You can also use the Remix Decks to build new tracks on the fly, layering up to eight clips on top of each other. Now let’s find out how to control the Remix Decks from your S2.

In case you were using Sample Decks in an earlier TRAKTOR version, don't panic! All former Sample Slot functionality stays preserved.

Prerequisites

As always, we assume here that you already followed the instructions in the previous tutorials. TRAKTOR KONTROL S2 now is in the following state:

- The track “Techno 2” is loaded on Deck B. The track is playing and audible. By the way, from now on we will use “Track Deck” to describe Decks that play tracks, so that we can easily distinguish Track Decks from Remix Decks. In TRAKTOR, you can see that the two upper Decks (A and B) are Track Decks, whereas the two lower Decks (C and D) are Remix Decks.
- The Deck A is stopped (if it’s not the case, press the PLAY button on the left Deck).
- The crossfader is all the way to the right.

4.5.1 Loading a Sample from the Collection

You can load Samples to REMIX SLOTS directly from your Track Collection:
1. Press the A button below the REMIX knob in the middle of the Mixer.

![REMIX knob](image)

This switches the CUE/REMIX SLOTS buttons on the controller to Remix Deck mode. The A button lights up, and the four CUE/REMIX SLOTS buttons 1-4 now control the four Sample Slots of Remix Deck C in the software.

2. Hold SHIFT and turn the BROWSE encoder to select the Track Collection folder from the Browser Tree. While keeping SHIFT depressed, press the BROWSE encoder button to expand the folder node.

3. Hold SHIFT and turn the BROWSE encoder to select the All Remix Sets folder from the Browser Tree. While keeping SHIFT depressed, press the BROWSE encoder button to expand the folder node.

4. Hold SHIFT and turn the BROWSE encoder to select the Dirty Trap folder from the Browser Tree.

5. Release SHIFT and turn the BROWSE encoder to highlight the Sample “C3 Bells #1” in the Playlist.

6. On the left Deck, press SHIFT plus one of the CUE/REMIX SLOTS buttons (let’s say the first one) to load the Sample into that particular Remix Slot:

![Sample Slots](image)

You can do this in the software too: simply drag and drop the sample from the list onto any Sample Slot.

The Sample is now loaded and ready to play:

- In TRAKTOR, the Remix Deck C now holds the Sample in the upper Sample Cell of the first Sample Slot.
- On your S2, the corresponding CUE/REMIX SLOTS button is now dimmed, indicating that the Remix Slot holds a Sample (which is not audible yet).

### 4.5.2 Triggering the Sample

Triggering the Sample is as simple as pressing the dimmed CUE/REMIX SLOTS button:

1. Press the dimmed CUE/REMIX SLOTS button to trigger the Sample.
2. Press the button again to mute the relevant Sample Slot. Press once more to unmute it.
3. Press SHIFT + CUE/REMIX SLOTS button to stop the Sample and skip back to start the next time it is activated.

The Sample is looped. This is because the sample is in **Loop mode**, which is indicated by the loop symbol on the left side of the Sample Cell:

![The Sample *C3 Bells #1* in Loop mode.](image)

To change the Play Type of the Sample to **One-shot mode**, the Advanced Panel of the Remix Deck needs to be opened. Double-click repeatedly on the upper border of the Deck to cycle through the Deck Layouts until the Advanced Panel becomes visible.
Click on the Play Type button in the lower right of the Advanced Panel (see screenshot above) to switch the Sample to **One-shot mode** if you wish.

In One-shot mode, pressing the relevant CUE/REMIX SLOTS button when a Sample is playing results in the Sample Slot being stopped.

Pressing **SHIFT + CUE/REMIX SLOTS** button once more after stopping Sample playback will clear the Sample from the Sample Slot.

In case you don’t hear the playing (unmuted) Sample, check that channel C’s fader is raised in the TRAKTOR software.

### 4.5.3 Capturing a Sample from a Track Deck

We have seen how you can load Samples directly into one of the Remix Decks using TRAKTOR’s Browser, but here’s an even cooler performance feature:

1. Check that the track “Techno 2” is still playing on the right Deck (Deck B in TRAKTOR). If not, start its playback by pressing **PLAY**. (If the playback has reached the end of the track, press **SHIFT + CUE** to skip back to start.)

2. To activate Remix Deck mode for the right Deck, press the right REMIX Mode button (labeled “B”) below the Remix Knob.
3. Set a Loop on Deck B, using the controls in the Loop section (as explained in chapter 4.4, Looping and Cueing).

4. Press an unlit CUE/REMIX SLOTS button — let’s say button 1.

→ This automatically captures the current Loop playing on Track Deck B, and copies it into the upper Sample Cell of the first Sample Slot on Remix Deck D underneath:

We just exported the active Loop from Deck B to the upper Sample Cell of Deck D's first Sample Slot.
The loop is now read to play in Remix Deck D. Furthermore, provided that Snap mode and SYNC are active, the loop is in perfect sync with the Track Deck B above.

The CUE/REMIX SLOTS buttons offer you the same playback controls as described earlier (press to unmute/mute the Sample, SHIFT+ press to stop it and skip to start next time it's activated, SHIFT + press again to unload).

As previously described, you can switch the Sample Play Type between Loop and One-shot mode (see ↑4.5.2, Triggering the Sample).

Now you can load a different track onto Deck B, but you will still have the Sample loop from the original song stored on the Remix Deck D to be retriggered at any time. It's great for capturing loops on the fly and using them to build an alternate mix.

If the Deck you copied from wasn't playing a Loop when you pressed the CUE/REMIX SLOTS button, it will still grab audio from the source Deck, but will instead take it from the current playback position. The loop will automatically be cut to the length of the current Loop size (as displayed in TRAKTOR).

► Capture a few Samples from various places in the track on Deck B and play around to get used to the basic playback controls that we described above (triggering, muting etc.).

4.5.4 Unloading a Sample

If at any time you’d like to clear the contents in one of the Sample Cells, hold the SHIFT button and press the corresponding CUE/REMIX SLOTS button to stop the Sample, and then repeat the same action to clear the Sample Cell. The CUE/REMIX SLOTS button turns back off.

The next tutorial will introduce you to TRAKTOR’s effects.

For a more in-depth description of the Remix Deck and its capabilities, please refer to the TRAKTOR 2 Manual.

4.6 Adding FX

Now that we have seen the basics of playing tracks and samples on the Decks and mixing them together, let’s see how to add effects — or “FX” in the TRAKTOR terminology.
TRAKTOR has an extremely powerful effect section. By default, there are two different FX Units in TRAKTOR, which can be assigned to any of the Decks. These FX Units are directly mirrored on your S2 above each Deck:

An FX Unit in TRAKTOR.

An FX Unit on the S2 controller.

**Prerequisites**

As always, we assume here that you already followed the instructions in the previous tutorials. TRAKTOR KONTROL S2 now is in the following state:

- The track “Techno 2” is loaded on Deck B. The track is playing and audible.
- The Deck A is stopped (if it’s not the case, press the PLAY button on the left Deck).
- The crossfader is all the way to the right.

### 4.6.1 Group Mode

TRAKTOR FX Units can be operated in two modes: Group mode and Single mode. In Group mode, one FX Unit hosts up to three of TRAKTOR's internal effects. In Single mode, one FX Unit hosts only one effect, but you can use the FX control knobs to control the effect's parameters.

First we'll look at Group mode. We’ll focus here on the left FX Unit (labeled FX1) of your S2 — but the same applies to the right FX Unit as well.
To set the FX Unit to Group mode, go to Preferences > Effects > FX Panel Mode and choose Group from the relevant drop-down menu.

In the TRAKTOR software, you see three different FX slots stacked on top of each other in the corresponding FX Unit (see picture above).

### 4.6.2 Getting the FX Unit Ready

Let’s load the three default effects and activate the FX Unit:

1. Hold the **SHIFT** button and press the FX On button (at the far left of the FX Unit, below the **DRY/WET** knob) to load the three default effects:

2. You now have the Delay, the Reverb, and the Flanger loaded.

3. Choose which of the three loaded effects you want to activate by pressing the corresponding FX Buttons 1-3. Of course, you can use all three effects together — simply activate all three buttons:

   The FX Buttons light up to indicate the activated effects.

4. As additional step, turn the **DRY/WET** knob fully counter-clockwise — we will use this knob later to progressively bring in the effects:

   → Your FX Unit is now ready to process whatever you will send to it!
### 4.6.3 Assigning Decks to the FX Unit and Bringing In the FX

Now we need to assign this FX Unit to a Deck. To do this, we use the FX Assign buttons at the top of each channel on the Mixer (below the **GAIN/FILTER** encoder):

![FX Assign buttons on each channel.](image)

Let’s assign the FX Unit 1 to Deck B:

1. Press the left FX Assign button (labeled “1”) on channel B to assign Deck B to the FX Unit 1.
2. Slowly turn the **DRY/WET** knob clockwise to bring in the FX.

→ You now hear the track on Deck B being processed by the FX Unit 1.

You can also assign another channel to the same FX Unit. For example, if you also want to apply these FX to the samples loaded on Deck C or D, simply press the FX Assign button “1” on the corresponding channel(s) in the software.

### 4.6.4 Controlling the FX Unit

You can control each FX in this FX Unit by turning the respective FX Knob 1-3:

![The FX Knobs 1-3.](image)

- Play around with the FX Knobs 1-3 and listen to the result on the audio. You can also activate/deactivate each FX individually by pressing the corresponding FX Buttons 1-3 below.

### Changing the FX in a Slot

You can load another FX in each slot. Let’s switch the first FX slot to the Gater:
1. Hold **SHIFT** and press the FX Button 1 repeatedly to scroll through all available FX until the Gater is selected in the first slot of the FX Unit 1 in TRAKTOR.

2. If the first FX slot is currently deactivated, press the FX Button 1 to activate it (the button must be lit).

→ You hear the Gater cutting the audio at regular intervals.

You might want to deactivate the FX Buttons 2 and 3 in order to better hear how the Gater affects the audio.

**Tempo-synchronized FX**

Now try the following:

► Set the FX Knob 1 to various positions and listen to the resulting effect on the audio.

→ You’ll notice that the gating effect stays synchronized to the beat! Among other things, this can be very useful to temporarily emphasize the rhythm, e.g., by transitions between tracks.

You can check this by moving the tempo fader on the right Deck: by pulling the fader downwards, you hear the track playing faster… and the Gater following.

**4.6.5 Single Mode**

You can also switch each FX Unit to Single mode. Instead of multiple FX with one parameter each, Single mode will give you one FX but with much more control over its parameters.

This time, we will do it on the right FX Unit (labeled FX2) of your S2:

1. In case your right FX Unit is set to Group mode, go to **Preferences > Effects > FX Panel Mode** and choose **Single** from the **FX2** drop-down menu to switch that FX Unit to Single mode.

2. Press **SHIFT + FX On button** for the FX Unit to load an FX. You can hold **SHIFT** depressed and continue to press the FX On button to cycle through all the available FX until you see an effect you’d like to try.

3. Press the same FX On button (this time without **SHIFT**) to turn on the FX Unit globally. The FX On button lights up.
4. On channel B, press the right FX Assign button (labeled “2”) to assign Deck B to this FX Unit as well. You can deactivate the left FX Assign button on that channel if you want to hear the new FX more distinctly.

The FX Knobs 1-3 and the FX Buttons 2 and 3 will give you access to each of the advanced parameters for that FX. At any time, you can press the FX Button 1 to reset the parameters to their default value.

As for Group mode, the DRY/WET knob allows you to adjust the balance between the unprocessed (dry) signal and the processed (wet) signal.

### 4.6.6 Storing a Snapshot of an FX UNIT

If you find yourself making the same settings to the FX each time and would like to set a default state for the FX parameters, simply do the following:

1. Adjust the FX knobs and buttons to your liking.
2. Click the Disk symbol on the lower left side of the FX Unit in the software.

The next time you load the effect, its parameters will assume the values you stored.

### 4.7 Synchronization

It is now time to give a closer look at the advanced synchronization features offered by TRAKTOR. Once you are more familiar with them, you will be able to use these powerful tools to build rich and complex mixes.

#### 4.7.1 Introduction

In the previous tutorials, we have already seen TRAKTOR’s synchronization facilities in action:

- We synchronized a track to the previous one before we mixed it in (see ↑4.2, Mixing In a Second Track).
- We played with Loops and jumped to Cue Points without losing the beat (see ↑4.4, Looping and Cueing).
- We grabbed a sample from a track and it played in sync with the track (see ↑4.5, Using Samples in Your Mix).
We noticed that the Gater FX was synchronized to the track it was processing (see \textsection 4.6, Adding FX).

For all this to work, TRAKTOR needs both a tempo and beat reference it can synchronize things with. We call this the \textit{tempo master}.

**The Tempo Master**

The tempo master is the one tempo source in TRAKTOR that all other elements can be synchronized to. The tempo master can be the internal TRAKTOR clock, or one of the Track Decks A and B. The tempo master doesn’t have to be the same throughout your mix, but there is always one tempo master — and only one.

So when activating the Sync function on a Track Deck (by pressing the \textit{SYNC} button), you tell TRAKTOR: “Synchronize the track on this Deck with the current tempo master.”

Possible sources for the tempo master:

- TRAKTOR’s Clock can provide a tempo and a tick.
- A Track Deck can provide the tempo and the beats from the track that is currently playing.

**The Beatgrid**

For a Track Deck to provide reliable tempo and beats as a tempo source, these characteristics must be precisely determined in the loaded track. Therefore, tracks must first be analyzed by TRAKTOR in order to determine the BPM as well as the position of the beats. The result of this analysis is the so-called \textbf{Beatgrid}. There is a specific Beatgrid for each of your tracks:

A track’s waveform and its Beatgrid (indicated by the white vertical segments).

The track’s Beatgrid is not only important when a Track Deck is set as tempo master, but also when you want this Track Deck to be synchronized with the current tempo master, whichever it may be.
The included demo tracks used in the tutorials were previously analyzed, therefore they already have a reliable Beatgrid. Before you can effectively use the synchronization facilities on your own tracks, you will have to analyze them. For more info on how to do this, see chapter 3, Preparing Your Music Library. For all the details on the Beatgrid, the Analysis and the Track Collection, please refer to the separate TRAKTOR 2 Manual.

**What Is Synched and What Is Not?**

Basically, samples playing in Looped mode and time-evolving FX are always automatically synched to the current tempo master.

For Track Decks, you can decide whether to use the automatic Sync function or not — for example if you want to beat match tracks manually (see tutorial in 4.2, Mixing In a Second Track), or if you don’t want any beat matching at all.

**4.7.2 Who’s the Master?**

You can build your mix using various Deck setups: you can mix with two Track Decks only, or make use of the lower Remix Decks (default setup).

Depending on your preferred way of DJing and Deck setup, you will have different needs and perspectives for choosing your tempo master. We will describe here the various use cases.

**Letting TRAKTOR Decide for You: the Auto Mode**

Let’s first give a look at TRAKTOR’s Clock:

► In TRAKTOR, click on the metronome icon at the top left of the window to show the Master Clock panel:

![The Master Clock panel in TRAKTOR.](image)

In the Master Clock panel, you see the activated AUTO button, meaning that we are in Auto mode.
The Auto mode is activated by default, and this is the mode we used in all the previous tutorials.

With **AUTO** activated, TRAKTOR automatically switches the tempo master between Track Decks when needed — that is to say, when the Track Deck set as tempo master is stopped or when you load a new track onto it. This way, you don’t have to worry about setting the tempo master yourself.

Should there be no other Track Deck playing, the Clock would become the tempo master, thus keeping in sync any FX and/or looped samples still on air!

You can check this by doing the following:

1. Stop any playing Deck.
   In TRAKTOR's Master Clock panel, the **MASTER** indicator lights up, indicating that the Clock currently is the tempo master:

   ![Master Clock Panel](image)

2. Load two tracks on Deck A and B.
3. Start the playback on Deck A.
   Deck A now is the tempo master: the **MASTER** button on left Deck Display in TRAKTOR lights up:

   ![Master Button](image)

4. Start the playback on Deck B and beat match the track on Deck B with that on Deck A (whether manually or via automatic Sync).
5. Stop Deck A.
Deck B now is the tempo master: the MASTER button on the left Deck Display in TRAKTOR turns off, whereas that of the right Deck lights up:

The Auto mode guarantees that each new track in the mix sets the tempo reference, and all FX and other Decks will synchronize to it correctly — without being constrained to a single tempo.

If you’d like to do a combination of manual and synched beat matching, again leave the AUTO button engaged in the software's Clock panel, and enable the SYNC button for individual Decks on your S2 as needed:

- If SYNC is enabled, the new Deck inherits the tempo from the previous tempo master.
- If SYNC is disabled, the new track sets the current tempo master.

Note that you can also manually set a particular Deck as tempo master:

► To manually set a Track Deck as tempo master, press SHIFT + SYNC on that Deck.

Using the Clock as Tempo Master

If you intend to only do beat-synced transitions, and would like to stay within the same general BPM range throughout your set, using the TRAKTOR Clock as tempo master would be the ideal mode to use. To set it up, do as follows:

1. In TRAKTOR’s Clock panel, deactivate the AUTO button.
2. Set the Clock as tempo master by activating the MASTER button in the Clock panel. The Clock panel should now look like this:

On your S2, activate Sync on both Decks by pressing the SYNC buttons.
This way, all Decks will instantly follow the Clock’s tempo. You can then set the Clock’s tempo to the tempo you intend to play your set via the numeric field to the right of the MASTER button (see picture above):

► Change the Clock’s tempo by clicking the displayed BPM value and dragging your mouse vertically while holding the mouse button depressed.

→ You can see the tempos on every Deck changing accordingly.

You can reassign the tempo master to one of the Track Decks at any time by pressing SHIFT + SYNC on the desired Deck on your S2.

4.7.3 Another Useful Tool for Synching

Lastly, we would like to quickly mention here another interesting features related to synchronization: the Keylock function.

Snap and Quantize Modes

As you probably remember, we already mentioned the Snap and Quantize modes in the tutorial in section ↑4.2, Mixing In a Second Track:

▪ The Snap mode ensures that any Loop or Cue Point you set in a track will snap to the closest beat.

▪ The Quantize mode ensures that any jump you make within the track will retain the phase sync — may you jump to a Loop, a Cue Point or a beat.

Both Snap and Quantize modes can be enabled/disabled in TRAKTOR by clicking the corresponding buttons in the Mixer on the software interface:

The SNAP (S) and QUANT (Q) buttons allow you to activate/deactivate Snap and Quantize mode, respectively.

Depending on what you are about to do, you can decide to enable or disable them at any time. Here are a few examples:
• If you want to set a Loop starting directly on a beat, activate Snap and press the LOOP SIZE encoder around the desired beat.

• On the contrary, should you wish to set a Cue Point at the beginning of some backing vocals that don’t necessarily start on the beat, deactivate Snap before pressing an unlit CUE/REMIX SLOTS button.

• If you’re about to mix in a synched track and want the downbeats of both tracks to perfectly match, activate the Quant button before you press PLAY (or one of the CUE/REMIX SLOTS buttons).

• If you were to jam around with a sample loaded on a Remix Deck and make some stutter-like effects by pressing the corresponding CUE/REMIX SLOTS button repeatedly (remember, the CUE/REMIX SLOTS buttons control TRAKTOR's Remix Decks C and D when in Remix Deck mode), you might prefer to deactivate Quant to create repetitions shorter than a beat.

• Etc.

**Locking the Key of Your Tracks**

When synchronizing tracks, you alter their tempo, and consequently their pitch (or key). For small tempo adjustments, this is not a problem. It can be a problem when the tempo is changed more drastically: kick sounds lose their power, vocals sound silly etc.

To avoid this, TRAKTOR KONTROL S2 provides you with a Keylock feature that uncouples the tone from the tempo of a track:

1. Load two tracks with quite different tempos on Deck A and B.
2. Start the playback on both Decks and synchronize Deck B to Deck A. You can clearly hear how the tone of the track on Deck B changed.
3. Now press **SHIFT + PLAY** on the right Deck of your S2. This activates the **KEYLOCK** on that Deck.
The tone of the track gets back to its original value, thus preserving most of its acoustic feeling. In the Deck section, the KEYLOCK indicator lights up to remind you that the Keylock is active on that Deck:

In conclusion, there is no “correct” sync setting: it all depends on your DJ style and the kind of music your sets will consist of.
Using the S2 with TRAKTOR DJ

The TRAKTOR KONTROL S2 is designed to work with the TRAKTOR DJ app on iOS devices. In this section we will describe the S2's key functions when using it with the TRAKTOR DJ app. The iOS devices referred to here are the iPad, iPhone and the iPod touch.

The iPhone app is known as TRAKTOR DJ for iPhone.

The S2 is currently compatible with the following iOS devices:

- iPhone 5c
- iPhone 5s
- iPhone 4
- iPhone 4S
- iPhone 5
- iPod touch (5th generation)
- iPod touch (4th generation)
- iPad 2
- iPad (3rd generation)
- iPad (4th generation)
- iPad mini

The iPad (4th generation), iPad Mini, and iPhone 5 all require Apple's Lightning-to-Dock adaptor to function with the S2.

5.1 Key S2 Functions Using TRAKTOR DJ

In this section we will identify how the S2's key functions operate when you are using the TRAKTOR DJ app on your iOS device.
5.1.1 Browsing & Loading Tracks

Follow the below tutorial to familiarize yourself with how to use the S2 to Browse through your music collection in TRAKTOR DJ and load tracks.

1. Press the BROWSE encoder to reveal the music file tree in TRAKTOR DJ. Here your music will be categorized into either Songs, Playlists, Artists, Albums, or Genre.
2. Press the BROWSE encoder again on Songs to enter into your song collection.
3. Turn the BROWSE encoder to scroll through your track collection.
4. Press either LOAD button A or B to load the track. The viewing mode in TRAKTOR DJ immediately switches back to Deck view mode. The LOAD button on the S2's deck will now become backlit orange to indicate that the track is loaded.
5. Trigger playback on the track.
6. Press the BROWSE encoder again, or press the LOAD buttons again to locate another track in TRAKTOR DJ.
7. Turn the BROWSE encoder again to locate another track.
8. On your selected track, press the BROWSE encoder again. TRAKTOR DJ's Recommended Tracks will be revealed. The app makes these recommendations on the basis of Key/BPM. If you wish to navigate your way back up a tree node at any point, you can do so by pressing a SHIFT button on the S2 whilst turning the BROWSE encoder. To navigate back up to the group level (Songs, Playlists, Artists..) hold SHIFT + press the BROWSE encoder.
9. Load your next track into the available S2 deck.

5.1.2 Deck Volume Controls and Crossfader

When using the S2 with the TRAKTOR DJ app, the device controls Decks A & B. The S2's A & B channel faders, therefore, control the volume of Decks A and B. If the crossfader is all the way to the left, you will only hear Deck A (if the volume fader of A is turned up). If it is all the way to the right, you will hear Deck B (if its volume control is turned up).

You will notice that when you move the S2's crossfader, the corresponding crossfader in TRAKTOR DJ moves simultaneously. Likewise with the channel faders.
The Mixer section of the S2, and the corresponding TRAKTOR DJ Equalizer section.

In TRAKTOR DJ, Deck A is located at the top, and Deck B found below. In TRAKTOR DJ for the iPhone, the deck view slider indicates that Deck A is located at the top and B at the bottom.

5.1.3 Using the Filters

The primary function of the S2’s GAIN/FILTER encoders controls TRAKTOR DJ's Filter effect for the corresponding Deck. To engage:

► Turn the GAIN/FILTER encoder. Turning clockwise cuts the low end frequencies, whereas turning counter clockwise cuts the high end. You'll also notice that when you move a GAIN/FILTER encoder clockwise (right), the Filter also moves to the right along its X axis within TRAKTOR DJ, and vice a versa counter clockwise.

To reveal the Filter display of TRAKTOR DJ Deck:

► Touch your finger on the Filter section of a TRAKTOR DJ Decks Equalizer display.
5.1.4 Adjusting Channel Gain

The secondary function of the S2’s GAIN/FILTER encoders controls TRAKTOR DJ's gain level for the corresponding Deck. To adjust gain level:

- Hold SHIFT + turn the GAIN/FILTER encoder. Turning clockwise, the gain level of the currently playing Deck increases. Vice versa, turning the knob counterclockwise will cause the gain level of the track playing to decrease.

Pressing SHIFT + the GAIN/FILTER encoder again, will reset the gain value.
5.1.5 Using the EQ's

When you move one of the S2's Eq buttons on either of Channels A or B, the corresponding effect can be observed via TRAKTOR DJ's Equalizer section. To reveal the Equalizer display of a TRAKTOR DJ Deck using the S2:

► Press FX button 2, located at either the top of channel A or B.

→ The Equalizer drawer will be revealed in the relevant TRAKTOR DJ deck.

The LOW EQ of Channel A being turned anti clockwise and the corresponding affect in TRAKTOR DJ's Equalizer.
5.1.6  Headphone Cueing

The **CUE VOL** knob located on the front panel of the S2 adjusts the volume levels of the headphone output. The **CUE MIX** knob determines whether you hear the main mix only, the cue channel only, or both signals in your headphones.

![Headphones input and CUE controls on the front panel of the S2.](image)

Cueing a track in your headphones works in the following way:

1. Load Decks A and B each with a track.
2. Click the **PLAY** button on both Decks to begin playback.
3. Turn the **CUE MIX** knob to the center position.
4. Set the headphone volume to a comfortable level by adjusting the **CUE VOL** knob.
5. With the channel faders up, move the crossfader back and forth to hear one track, then the other.
6. Move the crossfader all the way to channel A so that you are only hearing the track on Deck A. At the same time bring the channel volume fader all the way down for channel B.
7. Press the **CUE** button B. The button lights up, indicating that Deck B is now sent to the Cue channel, which you now hear in the headphones. Note that now, no matter where you move the crossfader, you will still hear Deck B, because its cue is on.
8. Press **CUE** button B again to toggle it off and press **CUE** button A. You will now hear the track playing on Deck A, no matter what position the crossfader is in. This is due to the fact that Deck A's Cue button is on, and the **CUE MIX** knob is still in the center position.
9. Press both **CUE** buttons A and B so that they are both active (illuminated).
10. Turn the **CUE MIX** knob all the way to the left.
11. Now toggle the two **CUE** buttons on and off. Notice that when both Cue buttons are off (unilluminated), there is no signal at all coming through the headphones.
12. Press both Cue buttons so that they are off.
13. Turn the CUE MIX knob all the way to the right. If the channel faders are up you will be able to hear the main mix coming through your headphones. Notice that when both channel faders are down, there is no signal at all coming through the headphones.

► Move the crossfader from one side to the other to hear the main mix in the headphone cue.

Remember that no matter what mix you are hearing in your headphones, the main mix is still controlled by the crossfader and channel faders.

### 5.1.7 Deck Control

An S2 Jog Wheel.

You can use the S2's jog wheels to scratch, find cue points, manually adjust a tracks tempo, rewind, and seek or search through a track.

**Seek through a Track**

You can seek through a track playing in TRAKTOR DJ by:
1. Pressing and spinning a Jog Wheel's top plate, you can seek through a track (to find a nice bring-in point for example).

2. Once you have found an interesting point for cueing (let's say a downbeat), keep pressing the top plate and release it when a downbeat arrives in the other track. Deck A starts playing from that point.

You can also stop the playback (by pressing the PLAY button) before you seek an interesting point with the Jog Wheel.

► Once you have found the point, you can release the jog wheel—since the Deck is not playing, you won’t lose the point. When a downbeat arrives in the other track, press PLAY again on the left Deck.

**Stripe Navigation**

When a track is playing in a TRAKTOR DJ Deck, you have the opportunity to engage Stripe Navigation. This function allows you to visually preview any point in the track without altering the current playback and at your choosing jump to that position of the track. Activate Stripe Navigation via:

► Press **SHIFT** + press and rotate the jog wheel on the currently playing Deck.

→ You can now navigate through the track to visually preview.

To jump to a desired position on the track:

► Press the **CUE** button.

To exit from Stripe Navigation view:

► Press the Loop **MOVE** encoder.

**Mixing Manually**

The S2 allows you to control TRAKTOR DJ's decks in a similar fashion to conventional turntables. With the **SYNC** mode off, you can nudge the jog wheels to create pitchbend. This may be the preferred DJ workflow for those who like to utilize manual beat matching.

With **SYNC** mode and **KEYLOCK** off, you can Pitch Bend.
With FLUX mode engaged, try experimenting with scratching the Jog Wheels, and triggering Hotcue buttons.

**Using the TEMPO Faders**

The S2 allows you to control the tempo of a track/s playing in TRAKTOR DJ by manually adjusting the Track Deck's tempo. Adjusting the tempo of the currently playing track's tempo adjusts the global tempo of TRAKTOR DJ. By default, the track playing will play at the currently selected tempo setting of the TEMPO fader. The TEMPO fader by default provides you with the opportunity to maneuver through a range of 8% of the tempo. There may be occasions, for example a track transition where you wish to navigate your way to a much faster or slower tempo for a track. You can do so via:

1. Depending on whether you want to speed up or slow down a track's tempo. Ensure that the S2's TEMPO fader is pushed to either end of its slider range (+ or -).
2. Hold SHIFT and then return the TEMPO fader to its central point. On releasing the SHIFT button, you can now work your way through the next BPM range (a range of 10 bpm, either faster or slower), you can repeat this process to speed up or slow down your tracks as you choose.

**TRAKTOR DJ allows you to utilize a tempo range of 8%/12%/25%/50%**

---

**5.2 Using the Transport Section**

The transport section of the S2 is located below the Jog Wheels on either side of the S2 device. The left transport section controls TRAKTOR DJ's Deck A, and vice versa the right-Deck B. Using the S2's transport section you can control:

- Playback (& Keylock) functions
- Cueing (& Restart)
- HotCues
- Loop Functions
- Move Functions
This section will take you through the functions of each button in the transport section. You will also learn how the RGB buttons behave when using the TRAKTOR DJ app.

### 5.2.1 PLAY buttons

Pressing either of the **PLAY** buttons will toggle playback on the corresponding TRAKTOR DJ Deck. Whilst the track is playing, pressing the **PLAY** button again will pause the deck.

When you initiate playback on one of the S2's **PLAY** buttons, the button will illuminate green.

### Keylock

The Keylock function of a TRAKTOR DJ Deck can be activated by pressing **SHIFT+ PLAY** on a TRAKTOR DJ Deck.

### 5.2.2 CUE Buttons

The use of the S2's **CUE** buttons function the following way in TRAKTOR DJ. If a track is playing, pressing the **CUE** button will insert a cue marker at this point but stop the track. Continuing playback, the track will jump back to the nearest stored cue point and commence playback from there.

### 5.2.3 SYNC (MASTER) Buttons

The **SYNC** button on the S2 allows you to automatically sync a track's tempo (in BPM) to the track currently playing in TRAKTOR DJ. The S2's **SYNC** buttons illuminate orange when engaged.

When using TRAKTOR DJ, there are occasions when a Deck is in a Half-Sync state. This is when the BPMs of the Decks match, but the phase alignment does not. For example:

- With two tracks playing, scratching one of the jog wheels (without a **FLUX** button engaged) and releasing out of time.
- With two tracks playing in Sync, and using Cue points out of time.
When a TRAKTOR DJ deck is in the Half-Sync state, the SYNC symbol of the TRAKTOR DJ deck will be lit red, and the corresponding S2 SYNC button will flash orange.

To reset the SYNC function:

► Press the S2's flashing SYNC button.

→ You will immediately hear the tracks align again. The S2's SYNC button is no longer flashing orange, and TRAKTOR DJ's SYNC is lit green.

**BeatGrid Edit Mode**

Pressing SHIFT + SYNC engages TRAKTOR DJ's BeatGrid Edit Mode on a corresponding Deck. Whilst in this mode, you can manually adjust a track's Beatgrid via:

- Moving the jog wheel to adjust the waveform/fixing the grid's phase.
- HotCues 1-4 can be used to select the correct downbeat you wish to use.
- Rotating the Loop MOVE encoders will scan through a track in increments of 4 beats.

**5.2.4 FLUX Buttons**

Pressing either of the FLUX buttons located above the TEMPO faders will engage TRAKTOR DJ's Flux Mode on the Deck. Flux mode lets you jump to cue points and loops without losing the overall phrasing of your tracks.

**5.2.5 HotCue Buttons**

The HotCue buttons are located as part of the CUE/REMIX SLOTS area on both of the S2's transport sections. Each CUE/REMIX SLOTS area contains 4 HotCue buttons (1-4). These RGB backlit buttons directly reflect TRAKTOR's cue button coloring:

- Blue: Cue point
- Green: Loop
- Yellow: Load
- Orange: Fade In/Out
- White: Grid Marker
TRAKTOR DJ will save the Beat Grid location as a Hotcue point; this is why many tracks will appear with one white Hotcue button.

When using TRAKTOR DJ's Loop Slicer, The S2's Hotcue buttons 1-4 control Slices and illuminate green when the mode is engaged. Refer to the section on Using Loops.

When using TRAKTOR DJ's Freeze Mode, The S2's Hotcue buttons 1-4 control Slices and illuminate blue when the mode is engaged. Refer to the section on Using Move Encoders/Freeze Mode.

To delete any stored cue points, loops etc., hold the SHIFT button whilst pressing the Hotcue button you wish to delete. The button will no longer be backlit.

**Setting Hotcue Points**

To make a new Hotcue point using the S2:

► Press one of the available (non backlit) Hotcue buttons.

→ The selected Hotcue button will now be backlit blue.

**5.2.6 Using Loops**

You can use the S2 to perform Loop functions in TRAKTOR DJ by either manually engaging the LOOP IN/OUT buttons, or by selecting a loop size with the Loop SIZE encoder and pressing to engage.
Triggering a loop in TRAKTOR DJ using the Loop SIZE encoder.

**Storing Loops Using the S2**

When you find those of so perfect sections of your track's to loop, you can use the S2 to store these by:

► With the Loop mode engaged, press an available (i.e. non backlit) Hotcue button.

→ The selected Hotcue button is now backlit green to indicate a loop is stored.

To delete any stored cue points, loops etc., hold the SHIFT button whilst pressing the Hotcue button you wish to delete. The button will no longer be backlit.

**Loop Slicer Mode**

1. Follow the instructions below to understand how to engage TRAKTOR DJ's Loop Slicer.
2. Trigger a loop on your chosen deck, using either the Loop SIZE encoder or manually via the LOOP IN/OUT buttons.
3. Press the Loop MOVE encoder to engage TRAKTOR DJ's Loop Slicer mode. You will notice that TRAKTOR DJ now displays the selected loop size into slices. The 4 Hotcue buttons on the S2 will now be backlit green indicating that they can now be triggered individually whilst the Loop Slicer is engaged.

4. Experiment by triggering the Hotcue buttons whilst in Loop Slicer mode.
Triggering Hotcue button 4 in TRAKTOR DJ’s Loop Slicer mode.

- Whilst in Loop Slicer mode, you have the opportunity to move the start point of the Loop by turning the Move Encoder. Turning to the left moves the start point of the loop to an earlier point in the playing track, whilst to the right a latter point. Pressing and rotating the Move encoder will move the Loop by 1 Beat.

- Whilst triggering the green Hotcue buttons in Loop Slicer Mode, experiment with turning the Loop Encoder to adjust the loop size for some interesting creative results.

5.2.7 Using the Loop MOVE Encoders

The Loop MOVE encoders serve a number of purposes when used with TRAKTOR DJ. The default mode of these encoders allows you Beatjump forwards or backwards in a tracks. Turning to the left moves backwards in the track, whereas to the right forward.
Waveform Zoom

Pressing **SHIFT** + rotating one of the S4's Loop MOVE encoders will zoom the waveform of the corresponding TRAKTOR DJ Deck. To the right zooms out-widening the track deck view, to the left zooms in to the track on a more micro level.

Freeze Mode

Pressing one of the S4's Loop MOVE encoders will engage Freeze Mode on the corresponding TRAKTOR DJ Deck. TRAKTOR DJ splits the Freeze Mode area into Slices. Hotcue buttons 1-4 on the corresponding S4 section will illuminate blue in this mode, and represent TRAKTOR DJ's Slices 1-4.

Pressing the Loop MOVE encoder to engage TRAKTOR DJ's Freeze mode.

Unlike Loop Slicer mode, Freeze Mode when engaged will continue playing when the playback marker exits the Freeze mode section.

Freeze mode takes the currently viewed section of the track playing, and allows you to trigger individual sections as cue points. These Freeze Mode cue points can be a section of a track, or down to a smaller component such as a hi-hat.
Triggering Hotcue button 2 whilst in Freeze Mode.

The scale of the Freeze Mode section, and individual cue sections depends on the viewing scale you are currently using. You can adjust the scale of which you are currently viewing a track by holding **SHIFT**+ turning the Loop **MOVE** encoder. To the right zooms out-widening the track deck view, to the left zooms in to the track on a more micro level. At this level you can trigger individual kicks, snares, hi hats etc.
Holding SHIFT + turning the Loop MOVE encoder to adjust TRAKTOR DJ's viewing scale.

When in Freeze Mode, turning the Loop MOVE encoder can be used to move around the assignments.

▶ Turning the Loop MOVE encoder, will move the Freeze assignments by the group size of assignments. Pressing and rotating the Loop MOVE encoder moves the assignments by one assignment size.

5.3 Using FX

This section is designed to get you swiftly up to speed with understanding how to deploy TRAKTOR DJ's effects. Follow the below tutorials to gain an understanding of how the S2 can be used to control them.

⚠️ TRAKTOR DJ has three banks of available effects, each of which contains eight effects.

5.3.1 Reveal a Deck's Effect Display

You can use the S2 to reveal a Deck's Effect display in TRAKTOR DJ by:

▶ Pressing FX button 1, located at the top of channel section A or B.
The effects display of TRAKTOR DJ will be revealed for the corresponding Deck. You will notice that the top of this Effects display contains three effects. Each of these represents the currently available effect as part of a bank.

To change the individual effects as part of the TRAKTOR DJ effects bank, you will need to manually select these within TRAKTOR DJ. Simply press the relevant effect section to reveal the drop down menu of 8 available effects in that bank.

The Effects Display section of TRAKTOR DJ.

5.3.2 Using the S2's FX Section

The S2 contains two FX sections, located above each of the jog wheels. Here you can trigger effects in TRAKTOR DJ by pressing the FX buttons (1-3), turn their corresponding FX knobs to control their effect parameter (visible along the X axis in TRAKTOR DJ), and further manipulate effect variables by using the DRY/WET knob which (visible along the Y axis in TRAKTOR DJ).

Triggering and Controlling an Effect

Pressing any of the S2's FX buttons (1-3) (located in the FX 1 or FX 2 sections) will engage the corresponding TRAKTOR DJ effect. When a button is pressed, you will notice that it illuminates orange. Within the Effects display of TRAKTOR DJ, the corresponding FX bank will also be highlighted orange.

Follow the below tutorial to familiarize yourself with how to utilize the S2 to control TRAKTOR DJ's effects:

1. Load a track into Deck A and begin playback.
2. Press FX button 1 at the top of Channel A to reveal TRAKTOR DJ's Effect display.
3. In TRAKTOR DJ, if not already selected by default, ensure the Delay effect is selected in the left-most bank.
4. Using the FX 1 section (located in the top-left) of the S2, press FX button 1. The button will illuminate orange; you will also be able to hear the Delay effect being applied to the track playing.

5. Move the FX knob 1 to either the left or the right. Observing TRAKTOR DJ, you will notice that your movements with the FX knob control the corresponding X axis in TRAKTOR DJ. Moving the FX knob to the right subsequently moves the Delay effect along its X axis.

6. With the effect still engaged, move the DRY/WET knob to the right. You will hear the amount of the Delay effect increase. This movement is mirrored on the Y axis within TRAKTOR DJ's Effects display.
7. Now turn FX Knob 1 all the way to the right. You will hear the amount of the Delay effect increasing and observe that the Effects Display moves to diagonally as both the Effect parameter moves to the both along the X axis and up the Y axis.

8. Now turn both of these knobs to the left. You will hear the amount of the effect applied lessens.

9. Now press FX buttons 2 and 3, so that all 3 FX buttons are engaged. All three FX buttons are now illuminated orange, and you will now hear that the track playing is affected by 3 of TRAKTOR DJ's effects.
10. Moving the **DRY/WET** knob will now control all three of the selected effect variables along TRAKTOR DJ's Y axis.
6 Hardware Overview

This chapter will give you an overview of the controller sections and their software equivalents.

6.1 Top Panel - Main Areas

This section will give you an overview of the controller's top panel areas and their software equivalents.

6.1.1 Decks

TRAKTOR KONTROL S2 provides you with two physical Decks. These Decks always control Track Decks A and B of the TRAKTOR PRO 2 software. However, there is a dedicated mode for controlling TRAKTOR's Remix Decks C and D with the CUE/REMIX SLOTS sections on both Decks. The corresponding mode is called Remix Deck mode, whereby the four CUE/REMIX SLOTS buttons on each Decks control the Remix Decks' Sample Slots. (See section ↑7.5, Using the CUE/REMIX SLOTS Section for more information on the CUE/REMIX SLOTS section's modes). To sum it up:

- The left Deck on your S2 controls the upper Track Deck A in TRAKTOR (and the lower Remix Deck C when in Remix Deck mode).
- The right Deck on your S2 controls the upper Track Deck B in TRAKTOR (and the lower Remix Deck D when in Remix Deck mode).
Deck A on your S2 controller.
Equivalent elements on the controlled Deck in TRAKTOR.

On your TRAKTOR KONTROL S2 controller, each Deck provides you with:

- a multi-function **jog wheel** with advanced transport functionality via its top plate (1) and outer rim (2).
- a **Tempo unit** (3) to adjust the playback speed.
- a **Loop section** (4) for setting and modifying loops.
- a **CUE/REMIX SLOTS section** (5) for setting and triggering Cue Points (or samples; see ↑7.5, Using the CUE/REMIX SLOTS Section for further reference).
- the traditional **PLAY** and **CUE buttons** (6).
- Both Decks also provide a **SHIFT button** (7): when held depressed, this button modifies the function of many other control elements (see section ↑7.1.3, SHIFT Buttons: Accessing Secondary Functions for more info).
- a **FLUX button** (8) to engage a TRAKTOR's Flux Mode.
Many control elements on the Decks can have their function customized in order to fit your specific needs and habits! For more info on this, please refer to chapter 8, Customizing TRAKTOR KONTROL S2.

Two Types of Audio Material – Two Deck Flavors

To start off with, there are four virtual Decks in the TRAKTOR software, and each of them can be operated in several modes: Track Deck mode, Remix Deck mode, and Live Input mode, so you have a very flexible system on your hands. However, in combination with the TRAKTOR KONTROL S2 controller, the software’s upper Decks A and B should always be Track Decks, whereas the software’s lower Decks C and D should always be Remix Decks. Setting up your S2 controller and the TRAKTOR software with the Setup Guide, this is how your software will be configured.

Your Decks can handle two different types of audio material, each of them leading to a specific Deck flavor:

- **Tracks**: A track is a song stored in digital format stored on your hard disk. For instance, the traditional way-of-DJing consists in playing back a particular sequence of tracks — a so-called Playlist. Decks handling tracks are called Track Decks. Working with the S2, TRAKTOR’s Decks A and B will always be operated in Track Deck mode.

- **Samples**: A Sample is a small piece of audio material. If its physical content does not really differ from a track’s content (it’s all about audio stored in digital format on your hard disk), the difference between them is both in their size and purpose: in general, a Sample is much shorter than a track, and it is aimed to be added to (or blended into) your main mix. Notably, Samples are perfect material for live remixing! Decks handling Samples are called Remix Decks. Each Remix Deck provides you with four Sample Slots, each of which can hold up to sixteen Samples, with a full set of Sample-related features. Working with the S2, TRAKTOR’s Decks C and D will always be operated in Remix Deck mode.

6.1.2 Mixer

The Mixer is sitting in the middle of your TRAKTOR KONTROL S2 controller and of TRAKTOR PRO 2’s window.
The Mixer receives on its **main channels** (1) the audio signals coming from the two Decks described above. There is one channel for each Deck. Hence, channels are labeled A and B according to their corresponding Deck. Additionally, there is a combined **Remix Deck channel** (2), controlling the volume of TRAKTOR's Remix Decks C and D. For this, you use the **REMIX** knob in the middle of the mixer.
As any DJ mixer, the Mixer’s purpose basically is to adjust the relative level of each channel, to control the channels’ frequency content, possibly feeding them into the FX Units (see section ↑6.1.3, FX Units) before sending the overall result to the Main section (3) — and in the end, to generate the mix that is sent to your audience. Of course, the Mixer also provides you with a crossfader (4), which allows you to make seamless transitions between various channels.

The Mixer of your TRAKTOR KONTROL S2 hardware controller has a few additional features not to be found on usual DJ mixers, though. For example, it includes a BROWSE encoder (5) for quickly browsing your Playlist content, along with a set of indicators in the Master Display (6) that give you quick access to vital information and options. You will find a detailed description of every control element on the Mixer in section ↑7.7, Using the Mixer.

Mixer-related controls dealing with the physical inputs and outputs of your TRAKTOR KONTROL S2 are also to be found on the front and rear panels of your S2 (see section ↑6, Hardware Overview).

### 6.1.3 FX Units

Adding effects to playing audio can tremendously expand the sonic possibilities of your mix. For that purpose, TRAKTOR provides you with a great selection of high-quality FX. These FX can be loaded into the so-called FX Units.

![The FX Unit 1 on the TRAKTOR KONTROL S2.](image)

The FX Unit 1 on the TRAKTOR KONTROL S2.

![The FX Unit 1 in TRAKTOR.](image)

The FX Unit 1 in TRAKTOR.

By default, two FX Units are active. Both FX Unit 1 and FX Unit 2 can be freely assigned to any of the channels A, B, C and D in TRAKTOR.
On the hardware side, the TRAKTOR KONTROL S2 also provides you with two FX Units (labeled FX1 and FX2 on your controller), which allow you to control the corresponding FX Units in the software.

You will find a detailed description of every control element in the FX Units in section 7.8, Using the FX Units.

You can activate two additional FX Units in the Preferences of TRAKTOR. Using four FX Units instead of two implies a few changes in the FX routing scheme.

### 6.2 The Rear Panel

This section describes all sockets and controls available on the rear panel of your TRAKTOR KONTROL S2. Together with the front panel, it provides you with the necessary elements for using other equipment with the TRAKTOR KONTROL S2 (headphones, microphone etc.) and setting your system up.

![](image)

The rear panel of the TRAKTOR KONTROL S2.

1. **MIC section**: Socket for connecting a microphone to your TRAKTOR KONTROL S2. See also section 6.2.1, MIC Section.

2. **OUTPUTS section**: Sockets for connecting the TRAKTOR KONTROL S2 to your main mixer or amplification system. See also section 6.2.2, OUTPUTS Section.

3. **Kensington lock slot**: Attach your Kensington lock here to protect your device against theft.

4. **POWER section**: See section 6.2.3, POWER Section for further information.
6.2.1  MIC Section

**GAIN knob**: Adjusts the gain of your microphone.

**MIC socket**: Microphone input (jack 1/4"

6.2.2  OUTPUTS Section

The OUTPUTS section holds sockets for the main outputs of your TRAKTOR KONTROL S2 controller.

**LEVEL knob**: Controls the RCAs' output gain when BOOTH/MAIN switch is set to BOOTH.

**BOOTH/MAIN switch**: Setting the switch to BOOTH allows for the RCAs' output volume to be controlled by the adjacent GAIN control knob instead of the MAIN volume knob of the Mixer. In MAIN mode, both RCA and the 1/4" sockets are controlled by the MAIN volume knob on the top of the Mixer.

**MAIN/BOOTH Outputs 1/2 RCA sockets (1/2)**: Main outputs of TRAKTOR KONTROL S2 (line level, unbalanced). Use these sockets to connect your TRAKTOR KONTROL S2 to an amplification system (or master mixer) with unbalanced inputs.

**MAIN Outputs 1/2 1/4" sockets (1/2)**: Main outputs of TRAKTOR KONTROL S2 (line level, balanced). Use these sockets to connect your TRAKTOR KONTROL S2 to an amplification system (or master mixer) with balanced inputs.
6.2.3 POWER Section

The POWER section holds the sockets for the connection of your S2 to your computer and to the power, along with the ON/OFF switch.

![POWER section on the rear panel.](image)

**USB socket**: Connect here your S2 to your computer with the included USB cable, or to your iOS device via the included Native Instruments iOS cable.

- **If possible, do always use the USB cable provided with the S2 box to operate your unit. Lower quality USB cables can affect transmission quality and ultimately worsen the S2's performance.**

**Power Supply connector**: Connect here the power cord.

**ON/OFF switch**: Engage the switch to turn on your device.

### 6.3 The Front Panel

This section describes all sockets and controls available on the front panel of your TRAKTOR KONTROL S2. The front panel of your S2 holds elements you might need during your mix.
The front panel of the TRAKTOR KONTROL S2.

**Headphones socket (PHONES)**: Cue channel stereo output (jack 1/4"). Connect your headphones here.

**Headphones Volume knob (CUE VOL)**: Adjusts the volume in your headphones here.

**Headphones Mix knob (CUE MIX)**: Adjusts the mix between master output and cue channel in your headphones here.

**MIC ENGAGE switch**: Engage the switch to turn on the microphone channel. The socket for the Microphone is situated on the rear panel (see ↑6.2.1, MIC Section).

Except for the MIC ENGAGE switch, all knobs on the front panel are retractable: by pushing them softly, you can hide them within the body of your controller to protect them against shocks during transport!

### 6.4 Types of Control Elements

Your TRAKTOR KONTROL S2 holds various types of control elements, which we will quickly describe here.
6.4.1 Buttons

A button (in this case, CUE/REMIX SLOTS button 2) on your S2.

**Buttons** are spread everywhere over your TRAKTOR KONTROL S2. They can have three flavors:

- Some buttons trigger a function when they’re pressed (“**trigger**” action), e.g., a CUE/REMIX SLOTS button: hit one of the CUE/REMIX SLOTS buttons, this triggers the playback to continue from there.

- Some buttons switch to another state until they are pressed again (“**toggle**” action), e.g., the **PLAY** button: hit it once and it starts the playback, press it a second time and the playback stops.

- A few buttons activate a certain state for the time they are held depressed (“**gate**” or “**hold**” action). Notably, this is the case with the **SHIFT** buttons (see below).

All buttons of your TRAKTOR KONTROL S2 are equipped with LEDs that give you various info. Basically, the LED indicates the button’s current state, but its exact meaning varies for each button — for more info, please refer to the description of each button later in this reference chapter.

**The SHIFT Buttons**

Instead of triggering any function themselves, the **SHIFT** buttons (one on each Deck) modify the behavior of other control elements on your TRAKTOR KONTROL S2, giving you access to some secondary functions.

For more info on the **SHIFT** buttons, please refer to section ↑7.1.3, **SHIFT Buttons: Accessing Secondary Functions**.
6.4.2 Knobs

![Knob on your S2.]

**Knobs** are rotary potentiometers with limited range — this is indicated by the limited white ring around them. By turning them, you can dial an absolute value for the parameter. The small white line on their top indicates the current value of the parameter within the defined range. Depending on their purpose, most of them have a center detent at the middle (default) position, which is shown by the little notch on their ring.

6.4.3 Encoders

![Encoder on your S2.]

**Encoders** are endless rotary controls — this is indicated by the full white ring around them. By turning them, you can dial a value for the parameter relatively to its current value in the software. All encoders have a step-by-step movement.

Additionally, encoders have a “push” action available: pushing the encoder can trigger some other function.
6.4.4 Jog Wheels

A jog wheel on your S2.

Functionally speaking, the two jog wheels are quite similar to the encoders described above: they have an endless rotary movement (here continuous) and an additional push action available on their top plate. The main difference (beside their size) is that, on the jog wheel, the push movement is very tiny and is rather used for detecting whether you put your hand on the top plate or on the outer rim when spinning the jog wheel. Hence, this leads to two different rotation controls:

- You can spin the jog wheel’s outer rim.
- You can spin the jog wheel by (pressing and) turning its top plate.

This makes the jog wheel a versatile element that gives you a very precise control, e.g. for scratching, seeking in a track, or browsing in lists.
6.4.5  Faders

A fader on your S2.

**Faders** are linear control elements with limited range. All of them set absolute values, with the possible exception of the tempo faders (see ↑7.3, *Using the Tempo Unit*).

6.4.6  Meters and Indicators

A meter.

**Indicators** and **meters** are single- or multi-LED elements that provide you with real-time feedback about various states and levels in the TRAKTOR KONTROL S2 system.
6.4.7 Switches

A switch.

**Switches** are only available on the rear panel. They control a few basic options needed when setting your TRAKTOR KONTROL S2 up.

6.4.8 Sockets

The RCA main output sockets on the rear panel of your S2.

**Sockets** are to be found on the rear and front panels only. They allow you to plug various types of cables (USB, audio, MIDI, etc.) into your TRAKTOR KONTROL S2.
7 Hardware Control Reference

This chapter details the use of the individual sections on your S2 controller. Whenever you need to know what a particular section on the controller can do, or how to achieve a specific task, refer to this chapter's contents.

In this chapter, we describe actions on the TRAKTOR KONTROL S2. Of course, every action on your S2 is instantly mirrored in TRAKTOR! For an in-depth explanation of all features provided by the TRAKTOR software, please refer to the TRAKTOR 2 Manual.

You will find in chapter 13, Appendix C – Quick References a series of Quick Reference tables summing up the basic functionality of each control element on your S2.

7.1 Things You Should Know

7.1.1 General Structure of the S2 Controller

Throughout the following sections, you will find detailed information on operating the controller's individual sections, e.g., the LOOP section, or the CUE/REMIX SLOTS section. It is, however, good to keep the general structure of the controller in mind when learning how to use it:

In general, the TRAKTOR KONTROL S2 consists of two Decks, left and right, and the Mixer, sitting in the middle of the device. The Decks control Track Decks A and B in the TRAKTOR software. An additional mode, the Remix Deck mode, allows you to control TRAKTOR's Remix Decks C and D from the controller's CUE/REMIX SLOTS sections.

The Mixer controls the volumes of the Track Decks A and B with its two main mixer channels. A third REMIX channel allows you to control the volume of TRAKTOR's Remix Decks C and D.

Hence, you can view the S2 as a controller for a very classic DJ mixing setup: two decks and a mixer (with the additional capability of firing off some samples in your mix).

What's also worth mentioning is the separate microphone channel with its dedicated gain control. This channel goes straight to the S2's main outs and works even when the S2 is not connected to a computer.
7.1.2  TRAKTOR's Deck Flavors: Track Decks Vs. Remix Decks

The TRAKTOR software provides you with four virtual Decks, A to D. Each of them can be operated in several modes (called Deck Flavors in TRAKTOR terminology): There is a Track Deck mode, a Remix Deck mode, and a Live Input mode (see also ↑6.1.1, Decks for more information on the Deck modes / Flavors). This makes TRAKTOR a very flexible system, customizable for umpteen scenarios. However, in combination with the TRAKTOR KONTROL S2 controller, the software's upper Decks, A and B, should always be Track Decks, whereas the software's lower Decks, C and D, should always be Remix Decks. Setting up your S2 controller and the TRAKTOR software with the Setup Guide, this is how your software will be configured.

7.1.3  SHIFT Buttons: Accessing Secondary Functions

The SHIFT buttons (one on each S2 Deck) act as “modifiers” for other control elements on your TRAKTOR KONTROL S2. In other terms, they allow you to access a secondary function when using other control elements simultaneously — much like the [Shift] key on your computer keyboard.

![SHIFT button](image)

A SHIFT button.

▸ To access the secondary function of any control element, hold SHIFT depressed when using that control element.

For the left and right Deck and for the FX Unit control elements, SHIFT operates locally, which means that you cannot use the SHIFT button on the opposite side of your S2 to access the secondary functions of the other Deck or FX Unit.

On the Mixer, the SHIFT button on either side can be used to access the secondary functions. In the documentation, the secondary function will sometimes be referred as “Shift layer“.

💡 On Track Decks, the SHIFT button additionally allows you to define the Deck tempo. See section ↑7.6.3, SHIFT Button for more info.
7.2 Using the Jog Wheels

The jog wheel (right Deck pictured).

The jog wheel has several functions, dealing with the playback of your track:

- **Tempo bending**: By spinning the jog wheel’s outer rim, you temporarily raise or lower the Deck tempo. When you stop spinning the rim, the Deck tempo returns to its original value.

- **Scratch**: By pressing and spinning the jog wheel’s top plate, you fully take over manual control for cueing up a beat, back spinning or for scratching. Also, this can be very useful to precisely locate any particular point in your track. When you release the top plate, the Deck returns to its previous playback state (playing or paused).

- **Seek**: By additionally pressing `SHIFT` when spinning the jog wheel’s top plate, you can fast seek through your track.

When you press the jog wheel’s top plate, the Load button A below the `BROWSE` encoder lights up to indicate that you are manually controlling the playback position.

The jog wheels also provide additional features:
Inside an active Loop, while holding the LOOP IN or LOOP OUT button depressed, use the jog wheel to adjust the Loop In Point or Loop Out Point, respectively. See section ↑7.3.2, Tempo Reset for more info on loops.

Your jog wheel can also be switched to a special Jog mode providing you with advanced features like FX control or filter control. Please refer to section ↑8.2.1, S2 Control Options for more info.

### 7.3 Using the Tempo Unit

The TEMPO fader provides you with extended control over the Deck tempo.

#### 7.3.1 Tempo Fader

![Tempo fader and Tempo Reset button](image)

The tempo fader controls the tempo of the focused Deck: Pulling the tempo fader downward/upward increases/decreases the tempo, respectively. By default, the range of the tempo fader is ±8 %.

You can change the tempo fader's range in Preferences > Transport > Tempo. Both the tempo fader in the software Deck and the tempo fader on your S2 are affected by this setting.
Absolute Mode

By default, the tempo fader is in Absolute mode. In this mode, whenever you move the tempo fader on your S2, its position is transmitted 1:1 to the tempo fader of the software Deck — no matter what the current position of the tempo fader on the software is.

In Absolute mode, the software Deck’s tempo always matches the tempo fader position on your S2, unless you have somehow changed the software Deck’s tempo by other means such as:

- Activating SYNC on that Deck to sync it to another tempo, thus modifying the tempo on the software Deck. As long as SYNC is on and this Deck is not the tempo master, the Deck tempo cannot be manually controlled via the faders (they are deactivated both on the software and hardware Deck).
- Moving the tempo fader in the software.

Relative Mode

You can also switch the tempo faders to Relative mode. In this mode, each tempo fader on your S2 affects the tempo fader of the software Deck relatively to its current position, even if this position does not match the position of the tempo fader on your S2. This notably resolves possible conflicts between the tempo fader and the Deck synchronization or Deck switching. To activate the Relative mode, open Preferences > TRAKTOR KONTROL S2 > S2 Control Options > Tempo Faders. Please refer to section ↑8.2.1, S2 Control Options for more info in this.

7.3.2 Tempo Reset

You can reset a TRAKTOR Deck its original speed by:

► Press SHIFT + the corresponding FLUX button on the S4.

→ The tempo of the focused Deck is reset to 0 % and the TEMPO fader is deactivated.

Locking the tempo will deactivate the tempo fader on the controller; however, a track's tempo can still be changed by syncing to another Deck (when SYNC is activated), and by operating the tempo fader on the software. To enable the TEMPO fader again:

► Press SHIFT + the corresponding FLUX button on the S4.
7.4 Using the LOOP Section

The Loop section holds all necessary controls for setting and modifying Loops in your tracks. The Loop section consists of two buttons in the middle and two push encoders on the sides. From left to right, you find the following controls: Loop MOVE encoder, LOOP IN button, LOOP OUT button, and Loop SIZE encoder.

7.4.1 LOOP IN and LOOP OUT Buttons

The LOOP IN and LOOP OUT buttons allow you to manually define a Floating Loop in the playing track.

Pressing the LOOP IN button sets a Floating Cue Point at the current playback position. This Floating Cue Point will serve as Loop In Point as soon as you press the LOOP OUT button.

**Hint:** The LOOP IN button is the perfect tool for setting a Floating Cue Point without stopping the playback, whether you set a Loop Out Point later or not!

Pressing the LOOP OUT button sets a Loop Out Point at the current playback position and activates a Floating Loop between the previously set Floating Cue Point and this Loop Out Point.

**You can reuse the same Loop In Point for several Loops:** simply set a new Loop Out Point, and the previous Loop In Point will be used for the new Floating Loop!
The **LOOP IN** and **LOOP OUT** buttons also act as indicator: they light up simultaneously to indicate that a Loop is running. If looping is active but the playback position is outside any Loop, only the **LOOP OUT** lights up.

► Hold the **LOOP IN** or **LOOP OUT** button depressed and spin the jog wheel to adjust the Loop In or Loop Out Point of the running Loop.

Bear in mind that all your actions affect a Floating Loop (and not the original Stored Loop, if any). Hence, if you plan to use the modified Loop later, don’t forget to store it! For example, you can do this by pressing an unlit **CUE/REMUX SLOTS** button (see section ↑7.5, Using the CUE/REMUX SLOTS Section).

The **LOOP IN** and **LOOP OUT** buttons can also have alternate functions when switched to Auto Loop mode. You can do this in **Preferences > TRAKTOR KONTROL S2 > S2 Control Options > Loop Buttons**. See section ↑8.2.1, S2 Control Options for more info.

### 7.4.2 Loop MOVE Encoder

![The Loop MOVE encoder.](image)

The Loop MOVE encoder allows you to activate/deactivate looping, move the Loop and jump in the track:

<table>
<thead>
<tr>
<th>LOOP MOVE encoder</th>
<th>No Loop active</th>
<th>Loop active</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn</td>
<td>Beatjumps by the current Loop size (as displayed in the Loop Control section in TRAKTOR).</td>
<td>Moves the Loop by the current Loop size (as displayed in the Loop Control section in TRAKTOR).</td>
</tr>
<tr>
<td><strong>SHIFT</strong> + Turn</td>
<td>Beatjumps by 1-beat steps.</td>
<td>Moves the Loop by 1-beat steps.</td>
</tr>
<tr>
<td>Push</td>
<td>Activates looping (current or next Loop in track will be looped).</td>
<td>Deactivates looping.</td>
</tr>
</tbody>
</table>
Bear in mind that all your actions affect a Floating Loop (and not the original Stored Loop, if any). Hence, if you plan to use the modified Loop later, don’t forget to store it! For example, you can do this by pressing an unlit CUE/REMIX SLOTS button (see section ↑7.5, Using the CUE/REMIX SLOTS Section).

### 7.4.3 Loop SIZE Encoder

The Loop SIZE encoder allows you to select/adjust the Loop size and to set a Floating Loop with the selected size:

<table>
<thead>
<tr>
<th>LOOP SIZE encoder</th>
<th>No Loop active</th>
<th>Loop active</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn</td>
<td>Selects a Loop size (in beats) for the next Floating Loop that you will set. The selected Loop size is displayed in the Loop Control section in TRAKTOR.</td>
<td>Halves/doubles the Loop’s size.</td>
</tr>
<tr>
<td>Push</td>
<td>Sets and activates a new Floating Loop at the current playback position with the selected Loop size.</td>
<td>Deactivates looping.</td>
</tr>
</tbody>
</table>

A Track Deck's Loop Size display in the TRAKTOR software.

You may have noticed that pushing either of the Loop MOVE and Loop SIZE encoders activates/deactivates looping. The only difference when activating looping via the Loop SIZE encoder is that you additionally set a new Floating Loop at the current position.

Bear in mind that all your actions affect a Floating Loop (and not the original Stored Loop, if any). Hence, if you plan to use the modified Loop later, don’t forget to store it! For example, you can do this by pressing an unlit CUE/REMIX SLOTS button (see section ↑7.5, Using the CUE/REMIX SLOTS Section).
7.5 Using the CUE/REMIX SLOTS Section

Depending on the mode, the four CUE/REMIX SLOTS buttons in each of the CUE/REMIX SLOTS sections on the S2 either control:

- Cue Points for TRAKTOR's Track Decks A and B (Cue mode).
- The Sample Slots of Remix Decks C and D (Remix Deck mode).

Refer to ↑6.1.1, Decks for details regarding Track Decks and Remix Decks.

7.5.1 Cue Mode

In Cue mode, the buttons represent the four Hotcue slots of the Deck. Hotcues allow you to quickly jump to the stored cue points and loops they are assigned to.

**CUE States**

When a TRAKTOR Deck is set to Track Deck. The RGB color on each CUE/REMIX SLOTS buttons indicates the current state of the slot:

<table>
<thead>
<tr>
<th>CUE button</th>
<th>Hotcue slot’s state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlit</td>
<td>Empty Hotcue slot.</td>
</tr>
<tr>
<td>Blue</td>
<td>Hotcue slot contains a Cue Point.</td>
</tr>
<tr>
<td>Green</td>
<td>Hotcue slot contains a Loop.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Hotcue slot contains a Load Marker</td>
</tr>
<tr>
<td>Orange</td>
<td>Hotcue slot contains a Fade-In or Fade-Out Marker</td>
</tr>
<tr>
<td>White</td>
<td>Hotcue slot contains a Grid Marker</td>
</tr>
</tbody>
</table>
Storing a Cue Point or a Loop into a Hotcue Slot

You can directly store the current playback position into a Hotcue slot by pressing an unlit but- ton, which represents an empty slot. A Cue Point or a Loop will be stored, depending on the current playback position:

▪ If the playback position is outside an active Loop, a Cue Point will be stored. The relevant CUE/REMIX SLOTS button lights up in blue.

▪ If playback is within an active Loop, this Loop will be stored to the Hotcue slot. The relevant CUE/REMIX SLOTS button lights up in green.

If you want to store a Cue Point while the playback position is within an active Loop, deac- tivate looping first — for example by pushing the Loop MOVE encoder.

Jumping to Predefined Hotcues

Pressing a lit CUE/REMIX SLOTS button jumps to that Cue Point / Loop. On a playing Deck, playback continues after the jump; on a paused Deck, the track is played from that Cue Point / Loop as long as the relevant CUE/REMIX SLOTS button is held depressed. Upon release, play- back stops and skips back to that point.

Deleting a Hotcue Slot

To delete the content of a Hotcue slot, press SHIFT + the desired CUE/REMIX SLOTS button. The button’s LED turns off.

By deleting a Hotcue slot, you also delete the Cue Point or Loop it contained.

7.5.2 Remix Deck Mode

In Remix Deck mode, the CUE/REMIX SLOTS buttons represent the four Sample Slots of Re- mix Decks C and D in the TRAKTOR software. Sample Slots allow you to capture Samples from the currently loaded track, and to load and play Samples from the Browser. To switch a con- troller Deck's CUE/REMIX SLOTS section to Remix Deck mode:

► Press the relevant Remix Deck mode button below the REMIX knob in the middle of the controller: A for the left Deck, B for the right Deck. The Remix Deck mode button lights up, signalizing that the relevant CUE/REMIX SLOTS section is in Remix Deck mode.
The four CUE/REMIX SLOTS buttons representing the four Sample Slots of a Remix Deck in Remix Deck mode.

For a quick introduction to the concept of Remix Decks, refer to section 6.1.1, Decks. Also don't miss the tutorial in section 4.5, Using Samples in Your Mix, which shows you the Remix Decks in action.

### CUE/REMIX SLOT States

The LED of each CUE/REMIX SLOTS button indicates the current state of the Sample Slot:

<table>
<thead>
<tr>
<th>CUE/REMIX SLOTS button</th>
<th>Remix Slot’s state</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unlit</td>
<td>Empty Sample Slot.</td>
</tr>
<tr>
<td>Dimmed</td>
<td>Sample loaded but stopped or muted.</td>
</tr>
<tr>
<td>Lit</td>
<td>Sample loaded and playing.</td>
</tr>
</tbody>
</table>

### Capturing a Sample from the Current Track

If a track is currently loaded into the Deck, you can directly capture a Sample from the track by pressing an unlit CUE/REMIX SLOTS button on that Deck. The Sample is copied from the current playback position, and:

- If the current playback position is within an active Loop, the Sample is a copy of the Loop. The playback position in the Sample then mirrors the playback position in the Loop.
- If the current playback position is outside any active Loop, the Sample starts at the current playback position. Its size is defined by the selected Loop size (as displayed by the Loop Size Display in TRAKTOR, see 7.4.3, Loop SIZE Encoder).

The relevant CUE/REMIX SLOTS button now lights up dimmed to indicate that the Sample is loaded but not audible, because it is either muted or stopped.

To tell whether the Sample is stopped or muted, give a look at the TRAKTOR window on your computer: If the Sample is muted, its waveform in the Sample Slot is dimmed, while the lit/unlit CUE/REMIX SLOTS button indicates whether or not the Sample is playing.

When capturing a Sample from the loaded track, as soon as the Sample is played live three times in the main mix, the sample is automatically saved to the Collection for later use!
Quick Loading a Sample from the Playlist

By holding SHIFT and pressing an unlit CUE/REMIX SLOTS button, you load the selected Sample from the currently active Playlist into the Sample Slot.

Playback Controls in Loop and One-shot Mode

Once a Sample is loaded into a Sample Slot, the relevant CUE/REMIX SLOTS button controls its playback. Its functionality depends on the Sample’s Play Type (Loop or One-shot mode). You can select the Sample's Play Type from the Advanced Panel of a Remix Deck. The Advanced Panel is not always visible, depending on the current Deck Layout; repeatedly double-click the Deck's upper border to cycle through the Deck Layouts until the Advanced Panel becomes visible.

![Image of Traktor Kontrol S2 with Advanced Panel]

The Remix Deck C with the Advanced Panel on bottom. On the lower right you can see the cursor pointing at the Play Type button, which switches between One-shot and Loop mode for the currently selected Sample Cell.

Click on the Play Type button in the lower right of the Advanced Panel to switch between Loop and One-shot mode for a Sample.

In **One-shot mode**, the whole Sample will be played once. The CUE/REMIX SLOTS button acts as follows:
In **Loop mode**, the Sample will be played back in loop. The CUE/REMIX SLOTS button acts as follows:

<table>
<thead>
<tr>
<th>Playback state</th>
<th>CUE/REMIX SLOTS button</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample stopped</td>
<td>Press to start playback.</td>
</tr>
<tr>
<td>Sample playing</td>
<td>Press to stop playback and reset it to start position.</td>
</tr>
</tbody>
</table>

### Unloading a Sample

You can clear a stopped Sample Slot by pressing `SHIFT +` the relevant CUE/REMIX SLOTS button. In case the Sample in the Sample Slot is playing, pressing `SHIFT +` CUE/REMIX SLOTS button will stop its playback. By carrying out this command again, it will clear the Sample Slot and the button’s LED turns off.

### 7.6 Using the Transport Control Area

#### 7.6.1 CUE and PLAY Button

![CUE and PLAY buttons](image)

The CUE and PLAY buttons.

At the bottom of the Deck, the **CUE** and **PLAY** buttons are the usual transport controls for the Deck.
CUE Button

The CUE button functions as follows:

- When the Deck is playing, pressing CUE skips to the Floating Cue Point and stops the playback.
- When the Deck is paused, pressing CUE sets a new Floating Cue Point (which replaces the previous Floating Cue Point). The track is played back from that Floating Cue Point as long as the CUE button is held depressed. Upon release, playback stops and skips back to the Floating Cue Point.

Pressing SHIFT + CUE skips back to the beginning of the track. The playback state (playing or paused) is left untouched.

PLAY Button

The PLAY button starts/stops the playback of the Deck. The button is lit when the Deck is playing.

Pressing SHIFT + PLAY activates/deactivates the Keylock on the Deck. When the Keylock is activated, the KEYLOCK indicator lights up in the Deck Display (see TRAKTOR 2 Manual and ↑4.7.3, Another Useful Tool for Synching for more info on key locking).

7.6.2 SYNC Button

The SYNC button activates/deactivates the synchronization of the Deck to the current tempo master (another Deck or the Clock). The button is lit when synchronization is activated.

Activating the synchronization disables the tempo fader if it is in the default Absolute mode. See section ↑7.3, Using the Tempo Unit for more info.
Pressing \texttt{SHIFT + SYNC} sets the Deck to \textit{tempo master} — the Deck tempo then serves as tempo reference for all other synched Decks and FX. When the Deck is set as tempo master, the \texttt{MASTER} button in the corresponding Deck section in TRAKTOR lights up (see \ref{4.7}, \texttt{Synchronization} for a tutorial on synchronization and setting the tempo master).

\begin{section}{7.6.3 \textbf{SHIFT Button}}

\begin{figure}[h]
\centering
\includegraphics[width=0.1\textwidth]{SHIFT.png}
\caption{The SHIFT button.}
\end{figure}

The \textit{SHIFT} button is a modifier: holding \texttt{SHIFT} depressed while using other control elements grants you access to their secondary function.

This element always has the same functionality, regardless of the Deck flavor (Track Deck or Remix Deck). It is described in detail in section \ref{7.1.3}, \textit{SHIFT Buttons: Accessing Secondary Functions} above.

\begin{section}{Tapping to the Beat}

On a Track Deck, tapping the \texttt{SHIFT} button can also help you to define the track's Beatgrid manually.

This allows you to redefine the Grid of a track from your S2 on the fly, would the Beatgrid ever appear to be wrong or missing.
7.7  Using the Mixer

The Mixer, in the middle of your S2.

This section describes the general handling of the Mixer on your TRAKTOR KONTROL S2.

You will find in §13.1, Quick Reference a Quick Reference table summing up the basic functionality of each control element on the Mixer.
Mixer Overview

The Mixer is equipped with two main channels, each of them controlling the signal coming from one particular Deck: channel A and B control the signals coming from Deck A and B (the left and the right Deck on the S2) respectively.

Thanks to the logical layout of the channels on the Mixer, you can quickly see what goes where:

- The left channel on TRAKTOR KONTROL S2 controls the signals coming from the left Track Deck (Deck A) in TRAKTOR.
- The right channel on TRAKTOR KONTROL S2 controls the signals coming from the right Track Deck (Deck B) in TRAKTOR.

Additionally, you have a combined channel to control the volume of TRAKTOR’S Remix Decks C and D, for when Remix Deck mode is activated.

Signal Flow

The signal coming from a Deck passes the following stations before being output at the main outs of the S2:

1. It arrives at the top of the channel at the GAIN encoder.
2. From there, it passes the EQ and Filter section.
3. It then possibly is tapped by the filter section, in case you have an FX Unit active and the Deck is assigned to it.
4. From the FX Unit, it is sent on to the channel fader and further on to the crossfader.
5. After the crossfader, the signal is sent to the MAIN section and finally to the output.

7.7.1 GAIN/FILTER Encoder

The GAIN/FILTER encoder.

The GAIN/FILTER encoders operate slightly differently in their functionality, depending on whether you are using TRAKTOR PRO software or the TRAKTOR DJ app with your S2 device.
When using TRAKTOR PRO, the GAIN/FILTER encoder controls the input level of the signal coming from the corresponding Deck before it passes the channel fader.

► Turn the GAIN/FILTER encoder to adjust the channel input gain.

This notably affects the resulting level as shown by the channel meter at the bottom: If the channel meter indicates that the signal is clipping, turn down the GAIN/FILTER encoder. For more info on how to set your levels correctly, see the tutorial in section 4.3, Adjusting Levels.

To reset a Deck’s input gain to 0 db:

► Push the GAIN/FILTER encoder.

The secondary function of the GAIN/FILTER encoders controls a TRAKTOR Deck’s Filter.

► Press SHIFT + turn the GAIN/FILTER encoder. Turning clockwise cuts the low end frequencies (HPF), whereas turning counter clockwise cuts the high end (LPF).

For an explanation on using the GAIN/FILTER encoders with TRAKTOR DJ, refer to 5.1.3, Using the Filters.

### 7.7.2 EQ Knobs

The EQ knobs.

Each channel boards an EQ section with the three usual knobs HI, MID and LOW for controlling high, medium and low frequency content of the signal, respectively.
Turn each EQ knob clockwise to emphasize the corresponding frequency band, and counter-clockwise to attenuate this band. At center detent position, the knob does not alter the signal.

TRAKTOR provides you with various types of EQ, each of them having its own “personality. You can choose the EQ type in Preferences > Mixer > EQ Selection. For more info, please refer to the TRAKTOR 2 Manual.

7.7.3 FX Assign Buttons

The FX Assign buttons (labeled “1” and “2”) below the GAIN/FILTER encoder allow you to assign the channel and its corresponding Deck both to the desired FX Units (normal layer) and to a particular side of the crossfader (Shift layer).

For the FX Unit assignment, press the left or right button to assign this channel to the FX Unit 1 or 2, respectively. The button lights up when the channel is routed to the corresponding FX Unit. When activating both buttons on the same channel, FX Unit 1 and FX Unit 2 will process the channel’s signal in series.

For a description of the FX Units on your S2, please refer to section 7.8, Using the FX Units.
7.7.4 Channel Fader and Channel Level Meter

The channel faders and their level meters.

The **channel fader** controls the relevant channel’s level, before the signal is sent to the cross-fader and Main section.

The **channel meter** gives you a visual feedback on the pre-fader level of the signal on this channel:

- Blue: The signal is below clipping.
- Orange: The signal is clipping.

This meter allows you both to check that the signal is neither too low nor clipping, and to visually match the level on this channel with the level on other channels in order to avoid level inconsistencies during transitions.

To correct the channel level, adjust the **GAIN/FILTER** encoder at the very top of the channel. For more info on how to set your levels correctly, see the tutorial in section ↑4.3, Adjusting Levels.
7.7.5 Crossfader

The crossfader controls the mix between the signal(s) assigned to its left and right side. At the center position, the crossfader has no effect: channel levels are then only defined by the respective channel faders (see above). At each crossfader’s end, the opposite signals are totally cut.

You can customize the fading curve of the crossfader in TRAKTOR’s Preferences. Please refer to the TRAKTOR 2 Manual for more info.

7.7.6 Main Section

The Main section allows you to both monitor and adjust the overall output level of your mix, i.e., the level of the signal sent to the Main Outputs on your S2. This is the last step for controlling the level on your S2, before your mix is sent to the outside world.
7.7.7  Headphones Cue Button

The Headphones Cue button (CUE) allows you to send the channel's signal to the cue channel — in other words, to your headphones. This is a basic feature for DJing, since it allows you to pre-listen the audio playing on that channel before sending it to the audience.

► Press the CUE button to send the channel’s signal to your headphones.

The Headphones CUE button lights up when activated, i.e., when the corresponding channel is sent to the cue channel.

See section ↑4.2.2, Using Headphones to Prepare the Mix for further instructions on using the CUE MIX function.

7.7.8  Master Display

The Master Display provides you with some vital information for your TRAKTOR KONTROL S2 system.

Alert Indicator

The Alert indicator.
The Alert indicator basically informs you that something might go wrong with your TRAKTOR KONTROL S2 system: the indicator flashes if the Main Volume knob or the Headphones Volume knob is too low in TRAKTOR, if the CPU meter is too high, or if the power supply of your laptop is disconnected.

**USB Indicator**

The USB indicator.

The USB indicator gives you information about the status of the USB connection between your S2 and your computer. The indicator should be continuously lit. If it flashes, there is no connection to the computer or a problem with the driver.

► Check that the USB indicator is continuously lit before going any further with your S2.

**Microphone Indicator**

The Microphone indicator.

The Microphone indicator is lit when the separate microphone channel is active. Press the **MIC ENGAGE** button on the controller’s front side to activate/deactivate the microphone channel.

For more info on the MIC section, see chapter ↑6.2.1, MIC Section.
7.7.9  Browse Encoder (BROWSE) and Load Buttons (A and B)

The BROWSE encoder.

The Load buttons (labeled A and B).

The BROWSE encoder and the LOAD buttons are used to browse and load tracks or samples in TRAKTOR KONTROL S2. You will find a description of their operation in section ↑7.9, Browsing, and Loading.

7.7.10  Remix Deck Knob and Mode Buttons (A and B)

The Remix Deck knob (SAMPLES) and the Mode buttons.
The **REMUX** knob controls the volume of TRAKTOR's Remix Decks C and D. To activate Remix Deck mode, press one of the Mode buttons A or B below; the **CUE/REMUX SLOTS** section on the corresponding deck will switch from controlling the Track Deck cues to controlling TRAKTOR's Remix Decks C/D. See ↑7.5, Using the **CUE/REMUX SLOTS** Section for further information on Cue mode and Remix Deck mode.

### 7.8 Using the FX Units

The FX Units 1 and 2 on your S2 allow you to control the FX Units in TRAKTOR. All controls of the FX Units in the software are mirrored on your S2.

![FX Units on S2](image)

The left FX Unit on your S2.

1. **FX On button**
2. **FX DRY/WET knob**
3. **FX Knob 1**
4. **FX Knob 2**
5. **FX Knob 3**
6. **FX Button 1**
7. **FX Button 2**
8. **FX Button 3**
7.8.1  Single Mode and Group Mode

In TRAKTOR, each FX Unit can work in two different modes:

- **Group mode**: Each FX Unit boards three different FX chained in series. Each FX can be controlled by one knob and one button.

- **Single mode**: Each FX Unit boards a single FX, which can be fine-tuned via the three knobs and three buttons of the FX Unit.

As a consequence, the control elements on an FX Unit will have different functions, depending on the current mode of this FX Unit.

You can set both modes in TRAKTOR's *Preferences > Effects > FX Panel Mode*.

7.8.2  FX Unit Reference

The following table sums up the functionality of each control element in the FX Unit.

<table>
<thead>
<tr>
<th>Control element</th>
<th>Single mode</th>
<th>Group mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>FX On button</td>
<td>Normal: activates/deactivates FX Unit globally (lit when activated).</td>
<td>Normal: not used.</td>
</tr>
<tr>
<td></td>
<td><strong>SHIFT</strong>: selects next FX from FX list (as set in <em>Preferences &gt; Effects &gt; FX Pre-Selection</em>).</td>
<td><strong>SHIFT</strong>: loads a set of three predefined FX (as set in <em>Preferences &gt; TRAKTOR KONTROL S2 &gt; S2 Control Options &gt; Direct FX 1-3</em>).</td>
</tr>
<tr>
<td>FX DRY/WET knob</td>
<td>Adjusts the ratio between unprocessed (dry) signal and processed (wet) signal.</td>
<td></td>
</tr>
<tr>
<td>FX Knob 1-3</td>
<td>FX parameter 1-3 (FX-dependent).</td>
<td>Parameter for 1st, 2nd, and 3rd FX.</td>
</tr>
<tr>
<td>FX Button 1-3</td>
<td>FX Button 1: resets all FX parameters to their default value.</td>
<td>Activates/deactivates FX slot 1-3 (lit when slot activated).</td>
</tr>
<tr>
<td></td>
<td>FX Buttons 2 and 3: FX-dependent (lit when activated).</td>
<td><strong>SHIFT</strong> + button: loads in this slot the next FX from FX list (as set in <em>Preferences &gt; Effects &gt; FX Pre-Selection</em>).</td>
</tr>
<tr>
<td></td>
<td><strong>SHIFT</strong>: loads a predefined FX (as set in <em>Preferences &gt; TRAKTOR KONTROL S2 &gt; S2 Control Options &gt; Direct FX 1-3</em>).</td>
<td></td>
</tr>
</tbody>
</table>
Assigning FX Units to Channels

The FX Units can be assigned to any number of channels in order to process the signals coming from the corresponding Decks. To do this, use the FX Assign buttons on the desired channels.

You can activate two additional FX Units in the Preferences of TRAKTOR. Using four FX Units instead of two implies a few changes in the FX routing scheme.

7.9 Browsing, and Loading

Your S2 makes the process of finding tracks and samples and loading them on to the desired Decks or Sample Slots easy:

You will find in §13.3, FX Unit Quick Reference a Quick Reference table summing up the basic functionality of each control element needed for browsing, loading and copying.

Browsing Tracks and Samples

You can quickly select tracks and samples for loading via the BROWSE encoder, located in the center of the Mixer:
The BROWSE encoder, at the top of the Mixer.

1. Hold SHIFT and turn the BROWSE encoder to scroll through the Browser Tree.
2. Hold SHIFT and press the BROWSE encoder to expand/collapse a folder node in the Browser Tree.
3. Release SHIFT and turn the BROWSE encoder to scroll through the tracks of the currently highlighted Playlist.

You can see the items being scrolled in the TRAKTOR Browser:
By turning the BROWSE encoder, you scroll the Playlist that is currently selected.

For more info on the Browser, the Playlists (and the Favorites), please refer to the TRAKTOR 2 Manual.

► To load the selected track or sample to a Deck, press the relevant LOAD button A or B below the BROWSE encoder:

For samples, you can also press SHIFT + the CUE/REMIX SLOTS button of an empty Sample Slot to load the selected sample into that Sample Slot (only when Remix Deck mode is active). Please refer to section ↑7.5, Using the CUE/REMIX SLOTS Section for more info on this.

7.10 Native TRAKTOR Mode Vs. MIDI Mode

Your TRAKTOR KONTROL S2 controller can be used in two modes: TRAKTOR mode and MIDI mode.

7.10.1 Native Traktor Mode

This is the mode that you will be normally using with TRAKTOR, which gives you access to all the features explained in this manual.

In Native Traktor mode, your TRAKTOR KONTROL S2 will communicate directly with TRAKTOR over USB using the Native Instruments proprietary NHL protocol, which features high resolution translation of the TRAKTOR KONTROL S2 knobs superior to MIDI.
7.10.2 MIDI Mode

The MIDI mode allows you to use your TRAKTOR KONTROL S2 as a regular MIDI controller.

In MIDI mode, the TRAKTOR KONTROL S2 will transmit only MIDI data via the virtual MIDI port that the TRAKTOR KONTROL S2 driver will provide to the host computer’s operating system.

Before proceeding with using the S2 in MIDI mode, you must check the Enable MIDI mode via Shift + Shift checkbox in the S2’s Preferences in TRAKTOR.

To switch your TRAKTOR KONTROL S2 between TRAKTOR mode and MIDI mode:

Hold SHIFT on one Deck and also press SHIFT on the other Deck of your S2.

When MIDI mode is enabled, both SHIFT buttons are lit.

To customize the S2’s MIDI properties, such as MIDI channel or CC numbers of its individual controls, Native Instruments has included the Controller Editor. The Controller Editor should have been installed during the TRAKTOR KONTROL S2 installation procedure. If you cannot find the Controller Editor on your computer, you can install it from the TRAKTOR KONTROL S2 installation disc.

TRAKTOR mode and MIDI mode may be used simultaneously, for example you can control TRAKTOR in TRAKTOR mode, then SHIFT + SHIFT to switch to MIDI mode to control other software or hardware over MIDI.
8 Customizing TRAKTOR KONTROL S2

TRAKTOR KONTROL S2 is a highly customizable DJ system. Many of its features can be modified so that it best suits your preferred way of DJing: customizable features include audio configuration, Decks, Mixer, transport controls, overall software layout, FX, Browser, file management, to mention a few.

Since the customization of TRAKTOR KONTROL S2 is not supposed to take place in a live situation, these settings are found in the software only. This also ensures you against accidental modification of the settings while playing.

8.1 The Preferences Window

Most customization options in TRAKTOR KONTROL S2 occur in the Preferences window.

The Preferences button, at the top right of TRAKTOR’s window.

Click the Preferences button, located in the right part of the Header (at the very top of TRAKTOR’s window) to open the Preferences of TRAKTOR.

Alternatively, you can select Preferences... in the File menu of the Application Menu Bar.

In the Preferences window, the settings are organized into various pages, each of them dealing with a specific part of your system:
1. To display a particular page of settings, click on the page name in the left column.
2. Adjust the settings according to your needs.
3. Once you have modified the desired settings, click **Close** at the bottom of the Preferences window to confirm your modifications.
8.2 Settings and Preferences for the S2 Control Elements

In this section, we will describe the available settings for the control elements sitting on the top panel of your TRAKTOR KONTROL S2 controller. The next section will present a few other settings of importance for your work with TRAKTOR KONTROL S2.

For a detailed description of all settings available in the Preferences window, please refer to the TRAKTOR 2 Manual.

In the Preferences window, the settings for the S2 have their dedicated page, judiciously called TRAKTOR KONTROL S2.

► In the Preferences window, click TRAKTOR KONTROL S2 at the bottom of the left column to display the page of settings for your TRAKTOR KONTROL S2 controller.
The settings for your TRAKTOR KONTROL S2.

In this page, settings are grouped into four sections: **S2 Control Options, Restore Default, Calibration** and **LEDs**.
8.2.1 S2 Control Options

On the TRAKTOR KONTROL S2 page of the Preferences, the S2 Control Options section allows you to adjust the way your TRAKTOR KONTROL S2 controller reacts to your actions. The following paragraphs thoroughly describe each of the available settings.

**Direct FX 1-3**

The three menus **Direct FX 1**, **Direct FX 2** and **Direct FX 3** allow you to choose the FX to be directly loaded when holding **SHIFT**.

![Direct FX 1-3 settings](image)

Reminder: In Single mode, press **SHIFT + FX Button 1**, **SHIFT + FX Button 2** or **SHIFT + FX Button 3** to load the selected Direct FX into the corresponding FX slot. In Group mode, press **SHIFT + FX On** to load all three Direct FX into their respective FX slots. See section ↑7.8, Using the FX Units for more info.

**Loop Buttons**

The **Loop Buttons** setting lets you choose alternate functions for the **LOOP IN** and **LOOP OUT** buttons on Track Decks.

![Loop Buttons setting](image)

The Loop section allows you to manipulate Loops in your track. See section ↑7.3.2, Tempo Reset for more info.

Following options are available:

- **Manual Looping** (default): When this option is selected, the buttons have manual looping functions:
When no Loop is active, the LOOP IN button sets a Floating Cue Point, whereas the LOOP OUT button sets a Loop Out Point and activates a Floating Loop between the Floating Cue Point (acting as Loop In Point) and this Loop Out Point.

When a Loop is active, holding one of these buttons while spinning the jog wheel allows you to move the corresponding Loop In Point or Loop Out Point.

- **Auto Loop**: When this option is selected, the buttons have auto looping functions:
  - When no Loop is active, the LOOP IN and LOOP OUT buttons set and activate a 4-beat and an 8-beat Floating Loop, respectively.
  - When a Loop is active, the LOOP IN button halves the Loop’s size while the LOOP OUT button doubles it.

### Tempo Faders

The **Tempo Faders** setting allows you to switch the tempo faders between Absolute mode and Relative mode.

The tempo fader is described in section ↑7.3, Using the Tempo Unit.

- **Absolute** (default): The tempo fader in the software Deck directly mirrors the tempo fader position on your S2 (see detailed description in section ↑7.3, Using the Tempo Unit).

- **Relative**: The tempo fader on your S2 affects the tempo fader on the software Deck relatively to its current position, even if this position does not match the position of the tempo fader on your hardware. This has the benefit of solving all possible offset-related issues occurring when you change the software Deck’s tempo by any other means (e.g. synchronizing the Deck to another tempo, switching the Deck focus, or moving the tempo fader in the software):
  - There is no more risk of any tempo jump when you touch the tempo fader.
The Tempo Offset buttons have the same functionality as in Absolute mode (indicating any offset between software and hardware faders, among other things). Additionally, they allow you to shift the range of the tempo fader: pressing a Tempo Offset button when both are unlit moves the range down/up by half range (e.g. by 6 % for the default range ±6 %). The tempo fader in the Software Deck jumps accordingly.

Like in Absolute mode, you can move the handle of the tempo fader to another position without altering the software Deck’s tempo by holding SHIFT depressed while moving the fader. This is not only useful to cover the whole range of the tempo fader in the software (should there be any offset between hardware and software faders), but it also allows you to go beyond this range and change the Deck tempo within ±100 % while preserving the current fader accuracy (as defined by the range set in Preferences > Transport > Tempo). Obviously, beyond the range of the software tempo fader, this fader does not represent the Deck tempo anymore. By moving the software fader with your mouse, though, the Deck tempo jumps back to the software fader position.

**Jog Wheel**

When the Disable Jog Wheel Push checkbox is ticked, the jog wheels' scratch control no longer responds to the scratch on message. This option is used in emergency operation or for DJ's that do not require scratching while a track is playing.

**LED Meters**

The LED meters display the VU (Volume Units) meters from TRAKTOR's internal mixer. The preference option between Master and PGM will set what gets displayed on the hardware's VU meters.

- **Master**: When set to master the LED meters display the current output of the master bus.
- **PGM** (default): When set to PGM the LED meters display the current PFL (pre-fader level) of deck A and B.

**8.2.2 Restore Default**

The Restore Default section holds only one element: the Restore button.
The Restore button.

Clicking on this button opens a warning message window, asking you if you really want to reset TRAKTOR KONTROL S2 to its default factory settings.

► Click Yes to confirm resetting TRAKTOR KONTROL S2 to its default settings. Click No to go back to the Preferences window without changing anything.

→ Upon confirmation, all TRAKTOR KONTROL S2 settings will be restored to default. You are now ready to start again with a fresh TRAKTOR KONTROL S2.

At any time, you can start the Setup Wizard to setup a fresh Deck and Controller selection. Simply select Start Setup Wizard in the Help menu of TRAKTOR’s Application Menu Bar (to see this bar, Fullscreen mode must be deactivated). See section 8.4, The Setup Wizard for more info on the Setup Wizard.

### 8.2.3 Calibration

The Calibration section allows you to perform the calibration for various knobs and faders on your S2, in order to correct potential inaccuracies of both center position (for the knobs) and range of the control elements.

The calibration can be done separately for four groups of control elements, each of them proposing its own Recalibrate button:

- **FX Knobs**: for recalibrating the FX DRY/WET knob and FX Knobs 1-3 on both FX Units.
- **EQ Knobs**: for recalibrating EQs and FILTER knobs on all channels of the Mixer.
- **Faders**: for recalibrating the TEMPO and channel faders.
- **Crossfader**: for recalibrating the crossfader on the Mixer.
- **Jogwheel**: for recalibrating the Jogwheels for channel A and B.

### 8.2.4 LEDs

The **LEDs** section provides you with two sliders that allow you to adjust the brightness for both states of all LEDs on your S2:
- **On State Brightness**: Sets the brightness for the On state of the LEDs.
- **Off State Brightness**: Sets the brightness for the Off state of the LEDs.

### 8.3 Other Settings of Interest

This section describes a few other settings of the TRAKTOR Preferences that affect the way your TRAKTOR KONTROL S2 reacts.

#### 8.3.1 Switching the Deck Flavors

Switching Deck Flavors is not advised for when using TRAKTOR in combination with the S2 controller. Decks A/B in Track Deck mode, and Decks C/D in Remix Deck mode is the only reasonable setting for controlling TRAKTOR with the S2 controller.

As explained in section ↑6.1.1, **Decks**, you can control Decks C and D via your TRAKTOR KONTROL S2. However, Decks C and D have to be set to Remix Decks. To do this, go to **Preferences > Decks Layout > Deck Flavor**.

The Deck Flavor section allows you to select another flavor for each of the lower Decks C and D.

In this section, each menu represents a Deck and is labeled accordingly.
To change the flavor of a lower Deck, click on the corresponding menu (C or D) and select the Remix Deck flavor from the drop-down menu. Click Close at the bottom of the Preferences window to confirm your modifications.

You can also reset your Decks to some basic configurations by starting the Setup Wizard. Bear in mind, though, that the Setup Wizard additionally resets all TRAKTOR settings to their default values. For more info on the Setup Wizard, please refer to section 8.4, The Setup Wizard.

### 8.3.2 Adjusting the Input Routing

The audio interface of your TRAKTOR KONTROL S2 is perfectly tailored for use with the TRAKTOR software. Its audio inputs can be routed to the desired locations in TRAKTOR, according to your current setup and needs. You can do this in two ways: via the Setup Wizard or via the Preferences of TRAKTOR.

#### Using the Setup Wizard

When setting up TRAKTOR KONTROL S2, the easiest way is to start the Setup Wizard. This allows you to choose from a set of basic Deck configurations and to forget about any audio routing settings — these will be automatically configured according to the selected Deck configuration!

Bear in mind, though, that the Setup Wizard additionally resets all TRAKTOR settings to their default values. For more info on the Setup Wizard, please refer to section 8.4, The Setup Wizard.

### 8.4 The Setup Wizard

The Setup Wizard is a convenient way to restart with a fresh “out-of-the-box” TRAKTOR KONTROL S2 setup. The Setup Wizard does two things:

- It lets you choose from a few basic Deck configurations and automatically sets the audio routing options accordingly.
- It resets all other TRAKTOR KONTROL S2 settings to their default values.

You can start the Setup Wizard in two ways:
Select *Start Setup Wizard* in the *Help* menu of the Application Menu Bar (to see this bar, Fullscreen mode must be deactivated).

Or

Click the *Setup Wizard* button at the bottom left corner of the Preferences window.

The Setup Wizard.

In the Setup Wizard you find a single menu, which lets you choose between four Deck configurations: *2 Track Decks* (default), *2 Track Decks + 2 Remix Decks*, *4 Track Decks* and *2 Track Decks + 2 Live Inputs*.

The Deck configurations are self-explanatory.

Note that you can only control *2 Track Decks + 2 Remix Decks* from TRAKTOR KONTROL S2.

Select the desired Deck configuration in the menu and click *Finish* to confirm your choice (or *Cancel* to leave the Setup Wizard without changing anything). In combination with the TRAKTOR KONTROL S2 controller, *2 Track Decks + 2 Remix Decks is the setting to work with*. 
The Setup Wizard activates the selected Deck configuration, configures the audio routing options accordingly and resets all other TRAKTOR settings to their default value.
9 The S2 Audio Interface and Control Panel

Your TRAKTOR KONTROL S2 is equipped with a high-end 24-bit/96 kHz audio interface. You can adjust the audio interface settings to your needs and computer performance.

Depending on whether you work on Windows or Mac OS X, you can adjust these settings in different ways.

9.1 Settings on Mac OS X

On Mac OS X, you can adjust the settings for the S2 audio interface from within each music application. In TRAKTOR:

► Open Preferences > Audio Setup to access the settings for the S2 audio interface.

There, you can adjust the audio interface settings of the TRAKTOR KONTROL S2. You have two settings:

- **Sample Rate**: Choose a sample rate that is compatible with your music application and suited to your computing power. A higher sample rate improves the audio quality, but also causes higher CPU load. Per default, the sample rate is set to 44100 Hz (CD quality).

  The sample rate defines how many samples are played/recorded per one second of sound. A higher sample rate results in higher audio quality; however, 44100 Hz (as used for recording audio CDs) is a common setting and absolutely sufficient for most tasks. If your final destination is CD you should use this setting or a multiple of it (88200 Hz). For a better understanding: 48000 Hz is used by DAT recorders, and for DVD (films) recording, 96000 Hz is typical for DVD, HD DVD, and Blue-ray Disc audio recording. You should be aware that a higher sample rate also causes higher CPU load.

- **Latency**: Lower the latency value for a quicker response of your computer to TRAKTOR controller and software actions.
When converting audio information to digital and vice versa, the audio driver needs to store the data in buffer packages (audio buffers) which are then sent to and processed by the CPU. The higher the buffer size, the longer it takes for a signal to finally arrive at the output as audio. You might experience this as late response in between hitting a key on a controller which controls music software on your computer, and hearing sound at the output. This delay is called latency. You should start off with a higher latency value, and gradually decrease it until you find the perfect balance between playability and audio quality for your system. If you experience crackling at the audio output, the latency value is very likely to be too low for your computer’s CPU to cope with, as lower latency values cause a higher load on the CPU.

### 9.2 Settings on Windows: The Control Panel

On Windows, the settings for the TRAKTOR KONTROL S2 audio interface are accessed via a little tool called TRAKTOR KONTROL S2 Control Panel. The Control Panel was installed during the TRAKTOR KONTROL S2 installation procedure. This section describes the TRAKTOR KONTROL S2 Control Panel user interface.

#### 9.2.1 Opening the Control Panel

You can open the Control Panel in various ways:

- From within TRAKTOR: Go to Preferences > Audio Setup and click the Settings button, located at the right of the Latency slider and display:

![Audio Setup](image)

- From your desktop: Go to Start > Programs > Native Instruments > TRAKTOR KONTROL S2 > TRAKTOR KONTROL S2 Control Panel.

Here is what you get when opening the Control Panel:

On the left side, you find two tabs: Audio Settings and Diagnostics.
Click on the tabs at the left to open the corresponding page of the Control Panel.

## 9.2.2 Audio Settings Page

The **Audio Settings** page allows you to adjust the settings of the audio interface.

The **Audio Settings** page consists of two sections:

- **Audio Processing**: settings for the analog-to-digital/digital-to-analog conversion done by your audio interface.

- **Device Monitor**: displays information about the audio interface's processing status and your system's output latency.

### Audio Processing Section

The **Audio Processing** section holds two menus and one display:

- **Sample Rate**: Choose a sample rate that is compatible with your music application and suited to your computing power. A higher sample rate improves the audio quality, but also causes higher CPU load. By default, the sample rate is set to 44100 Hz (CD quality).
The sample rate defines how many samples are played/recorded per one second of sound. A higher sample rate results in higher audio quality; however, 44100 Hz (as used for recording audio CDs) is a common setting and absolutely sufficient for most tasks. If your final destination is CD you should use this setting or a multiple of it (88200 Hz). For a better understanding: 48000 Hz is used by DAT recorders, and for DVD (films) recording, 96000 Hz is typical for DVD, HD DVD, and Blue-ray Disc audio recording. You should be aware that a higher sample rate also causes higher CPU load.

- **Process Buffer**: Lower the buffer size value for a quicker response of your computer to TRAKTOR controller and software actions.

When converting audio information to digital and vice versa, the audio driver needs to store the data in buffer packages (audio buffers) which are then sent to and processed by the CPU. The higher the buffer size, the longer it takes for a signal to finally arrive at the output as audio. You might experience this as late response in between hitting a key on a controller which controls music software on your computer, and hearing sound at the output. This delay is called latency. A rule of thumb is: lower buffer size results in lower latency. However, there are more factors to latency than buffer size alone (e.g., CPU speed and RAM size). You should start off with a higher buffer size setting, and gradually decrease the value until you find the perfect balance between playability and audio quality for your system. If you experience crackling at the audio output, the buffer size is very likely to be too low for your computer’s CPU to cope with, as lower buffer size causes higher CPU load.

- **USB Buffer**: Use this menu in case you cannot achieve satisfactory Latency settings with the Process Buffer menu. Lower the USB buffer size for smaller USB buffer packaging, which should further reduce the audible latency. If you notice any audio interruptions, you should raise the buffer size until you have a clear sound, free of dropouts.

**Device Monitor Section**

The **Device Monitor** section holds two displays:

- **Processing State**: The processing state monitor provides feedback on the current status of the device. There are three possible status messages:
  - **Idle**: controller is connected, but no audio data is being streamed.
  - **Streaming**: driver is working and processing audio data.
  - **Panic**: driver stopped streaming. Too many USB I/O errors occurred in the interface communication.

- **Output Latency**: displays your system’s output latency in milliseconds.
Notice there is also an input latency when working with the TRAKTOR KONTROL S2. The output latency value does not represent the overall latency, from pressing a button on the controller to hearing the resulting effect at the output. The overall latency is about twice as long as the output latency.

9.2.3 Diagnostics Page

The Diagnostics page allows for monitoring the controller’s performance and for detecting errors.

The Control Panel with Diagnostics page opened.

The information provided in the Diagnostics page might be more of interest to advanced users; however, in case of problems, you should always have a look at this page.

The Diagnostics page consists of three sections:

- **Drop-Out Detection**: displays USB I/O errors and buffer underruns when detected.
- **Connection Monitor**: displays client-to-driver connections and USB data errors when detected.
- **System Performance Test**: offers the possibility to run a performance test to measure latency values.
- **Information**: displays information on driver and firmware version. There is also a link to the Troubleshooting Guide here.

**Drop-Out Detection Section**

The Drop-Out Detection section holds two displays and a button:
- **USB I/O Errors**: counts USB input/output errors. A high **USB I/O Errors** count points to your system being overloaded.
- **Buffer Underruns**: Buffer underruns occur when your computer isn’t able to process an audio buffer in time. Reasons for underruns can be too many ongoing background tasks or high CPU usage within a music program that uses the device as audio driver.
- **Reset**: A click on this button resets the error count.

**Connection Monitor Section**

The Connection Monitor section holds two displays and a button:
- **Number of Clients**: displays the number of clients connected to the interface. Multiple ASIO applications are counted separately, WDM and WASAPI increase the number by one, no matter how many WDM/WASAPI applications play audio.
- **USB Data Errors**: counts USB data errors. Poor quality or long cables as well as irradiation can be the source of data errors on the USB bus.
- **Reset**: A click on this button resets the error count.

**System Performance Test Section**

- **Current Latency**: Click on the **Start** button below to display the current latency value here.
- **Maximum Latency**: displays the highest value that was during the current measuring cycle.
• Clicking on Reset has the same effect as clicking on Start for the first time. It resets the testing procedure to its beginning and starts a new test with fresh values.

• Clicking on Stop will end the test. The Maximum Latency value will remain displayed.

**Information Section**

The Information section holds two displays and a button:

- **Driver Version**: See the currently installed driver version here.
- **Firmware Version**: See the currently installed firmware version here.
- **Troubleshooting Guide**: Click Show to open the Troubleshooting Guide.

### 9.3 Using the S2 as your Default Audio Output Interface

If you want to use the TRAKTOR KONTROL S2 for playback of all audio applications on your computer (not only for music software), you have to set it as your default audio interface.

#### 9.3.1 Windows

For Windows 7 (and later), you can define the TRAKTOR KONTROL S2 as your default audio interface as follows:

1. Open **Start > Control Panel > Sound**.
2. Select the **Playback** tab.
3. In the device list, select **TRAKTOR KONTROL S2** and click **Set Default**.
4. Select the **Recording** tab.
5. In the device list, select **TRAKTOR KONTROL S2** and click **Set Default**.
6. Click **OK** to close the dialog.

#### 9.3.2 Mac OS X

For Mac OS X, you can define the TRAKTOR KONTROL S2 as your default audio interface as follows:

1. From the **Apple** menu, select **System Preferences**.
2. In the panel that opens, click Sound.
3. On the Sound Effects tab, select TRAKTOR KONTROL S2 in the Play alerts and sound effects through menu.
4. Click the Output tab, and select TRAKTOR KONTROL S2 from the Choose a device for sound output list.
5. Click the Input tab, and select TRAKTOR KONTROL S2 from the Choose a device for sound input list.
6. Close the window to confirm your changes.
10 Troubleshooting and Help

This chapter covers the most common issues. Most of what can go wrong when setting up and using TRAKTOR KONTROL S2 should be listed here along with some tried-and-tested ways to solve these issues.

10.1 TRAKTOR Won’t Start

1. Check the system requirements for TRAKTOR KонтROL S2. The minimum requirements are the very least you can get by with, and are often not enough for advanced use (i.e., Keylock, FX). Increasing your RAM may save you a lot of trouble.
2. Make sure you have the most recent TRAKTOR version installed.
3. Make sure that you have not clicked an outdated application alias/shortcut.
4. Try to restart your computer. Disconnect any other audio interfaces and computer peripherals like printers, scanners, and the like.
5. Try to rename the file `collection.nml` in the TRAKTOR KONTROL S2 Root folder to restart TRAKTOR with a clean Collection, and then re-import the renamed Collection. For more info on the Root folder, please refer to the TRAKTOR 2 Manual.

10.2 Hardware-related Problems

This section lists the points that you shall check when something seems to be wrong with your TRAKTOR KONTROL S2 controller.

10.2.1 Basics

This might sound obvious, but the first things to check are following:

- Make sure that the TRAKTOR KONTROL S2 is connected to the computer via the included USB cable.
- Check that the controller is turned on (ON/OFF switch on the rear panel must be engaged).
10.2.2  USB and Driver Issues

Once your TRAKTOR KONTROL S2 is connected and turned on, wait a few seconds and give a look at the USB indicator located in the Master Display, in the middle of your device:

![USB indicator in the Master Display](Image)

If the USB indicator is flashing, there is no connection to the computer or there is a problem with the hardware driver. Please check the following points:

- The TRAKTOR KONTROL S2 is a USB 2.0 device and will not work on a USB 1.0/1.1 port.
- A bad USB cable can be responsible for connectivity problems. Try using a different cable bearing the official USB logo, in some cases using a shorter cable might help.
- On Windows: Check that the driver is correctly installed. You can do this for example by looking for the TRAKTOR KONTROL S2 Control Panel (see ↑9.2.1, Opening the Control Panel for more info). If you cannot find the Control Panel, the driver is most likely not installed at all. In this case, please re-install the driver from the TRAKTOR KONTROL S2 installation disc as described in the separate Setup Guide.

10.2.3  Updating the Driver

► Check NI Service Center regularly for driver updates.

10.2.4  USB-related Power Issues

We strongly recommend you to use an external power supply with your S2 via the included power supply unit. Although operation is also possible when your S2 is powered via the USB connection, you then have following limitations: the headphones output level is lower, and all LEDs light darker.

If for any reason you cannot make use of any external power supply, you should check the following points:
- The port needs to fulfill the minimum power specification for a USB 2.0 port (500 mA). On certain computers, the USB 2.0 ports do not meet the official USB 2.0 power specification. In this case, you may see a message, saying that there is not enough power available to operate your device. The TRAKTOR KONTROL S2 may produce crackles or may not work at all.

- In case of failures, it is useful to check if TRAKTOR KONTROL S2 works if you disconnect any other USB device from the computer.

- If your computer is unable to supply the necessary amount of bus power, try connecting your TRAKTOR KONTROL S2 to a USB 2.0 hub with external power supply. Avoid connecting other devices to the hub, as each bus-powered device takes its share from the total amount of power available.

Once again, the best way to avoid any power-related issue with your S2 is to connect the included external power supply unit!

When using the S2 with TRAKTOR DJ on an iOS device, the Native Instruments iOS cable allows the device to charge.

10.2.5 Using the TRAKTOR KONTROL S2 with a Laptop

Check if your computer is suited for handling real-time audio processing without dropouts. The TRAKTOR KONTROL S2 Control Panel provides you with a useful tool to achieve this. See chapter ↑9.2.2, Audio Settings Page for more info.

In general, it is not recommended to use laptops with shared-memory graphic cards. You will need all the memory and processing power available for your audio software.

There are some steps to optimize your laptop’s audio performance:

- It is not recommended to run the laptop on battery, as power management might slow the clock rate of the CPU down, to save battery.

- Disconnect all unused hardware (e.g. printer, scanner). This will increase the amount of processing power available for your music software.

- Laptops often are equipped with built-in devices that disturb audio processing, most commonly a network adapter or a wireless LAN card. You might need to disable these devices while working with the TRAKTOR KONTROL S2.
10.3  **Loose Jog Wheel Top Plate**

The flat, round, push-sensitive surface of the jog wheels on your TKS2 was designed to be easily replaceable. Due to heavy shocks or extreme vibration during travelling, in some rare cases a jog wheel top plate might become loose or detached from the controller.

It can easily be reattached to the base of the jog wheel. To do this:

1. Align the connector pins on the bottom of the top plate with the corresponding clips on the jog wheel base.
2. Hold the rubber rim of the wheel steady with one hand.
3. Use the other hand to push the plate down into the round central area of the jog wheel and twist the plate around to the left (anti-clockwise) until the pins click back into the clips on the base (you may hear a clicking sound).

Once the plate has clicked back into place, it should be securely fastened to the unit. If it is still loose, try running through the procedure again. Although it may not be necessary for optimum use, we recommend recalibrating your jog wheels after detaching and reattaching the jog wheel top plate. For further details on jog wheel calibration, please refer to the separate Jog Wheel Calibration Guide in the TRAKTOR 2 documentation folder. The guide was initially written for the TRAKTOR KONTROL S4, but jog wheel calibration for both devices employs the exact same methods.

10.4  **TRAKTOR Crashes**

In case of a crash during runtime, please contact the Native Instruments technical support team and send them your crashlog. You will find the crashlog in the following folders:

- **Windows**: `\My Documents\Native Instruments\Traktor 2\Crashlogs`
- **Mac OS X**: `Users/~/Library/Logs/CrashReporter/`
10.5 Getting Help

10.5.1 Knowledge Base / Readme / Online Support

Open the Service Center application and click on the Support button in the upper right corner. Here you will find direct links to the Native Instruments Online Knowledge Base and the Online Support Form.

The Online Knowledge Base gathers useful information about your Native Instruments product and can be of great help to solve possible issues you may encounter when working with Native Instruments products.

If no Knowledge Base entry matches your problem, or if the matching entry does not solve the problem, you can use the Online Support Form to contact the Technical Support team with Native Instruments. The Online Support Form will ask you to enter information about your hardware and software setup. This information is essential for our support team to be able to provide you with quality assistance.

When communicating with the Native Instruments support team, keep in mind that the more details you can provide about your hardware, your operating system, the version of the software you are running, and the problem you are experiencing, the better they will be able to help you. In your description, you should mention:

- How to reproduce the problem
- What you have already tried to fix the problem
- A description of your setup, including all hardware
- The brand and specifications of your computer

When installing new software or software updates, a Readme file is included that contains late breaking news and new information that was not yet included in the documentation. Please open and read this Readme file before contacting Technical Support.
10.5.2 Forum

In the Native Instruments User Forum you can discuss product features directly with other users and with experts moderating the forum.

http://www.native-instruments.com/forum

10.6 Updates

Whenever you encounter problems, it is recommended that you first download and install any available software updates. Updates are released regularly to fix known problems and to continuously improve the software. The version number of your software is displayed in the About dialog for any Native Instruments application. This dialog can be opened by clicking on the NI logo in the upper right corner of the user interface. Alternatively, you can find the version numbers of all installed Native Instruments applications when showing the details for an application within the Overview page of the Service Center. Updates are available on the Update page in Service Center or on our website under:

http://www.native-instruments.com/updates
Appendix A – Common Setups

This appendix shows you how to connect your TRAKTOR KONTROL S2 with your other gears in various setups.

For a reference of each socket or control element to be found on the rear and front panel of the TRAKTOR KONTROL S2, please refer to section ↑6.2, The Rear Panel and ↑6.3, The Front Panel, respectively.

It goes without saying that all setups require that TRAKTOR KONTROL S2 was correctly installed on your computer beforehand! For more info on the installation procedure, please refer to the separate Setup Guide.

We will first describe the most basic setup. Then, we will show you some interesting add-ons.

11.1 TRAKTOR KONTROL S2 Basic Setup

This setup is the most common. It is also described in the Setup Guide and used in most of the tutorials.

Let’s start with the fundamentals: the S2, your computer, your headphones, and an amplification system.
Connect the Power Supply

1. Connect the included power supply to a power outlet using the appropriate adapter for your region.

2. Connect the power cord plug to the Power Supply connector (labeled POWER) on the rear panel of your S2.
We strongly recommend you to use an external power supply with your S2 via the included power supply unit. Although operation is also possible USB-powered, you'll have following limitations: the headphones output level is lower, and all LEDs light darker. Moreover, your device might then be subject to USB power-related issues, as explained in section 10.2.4, USB-related Power Issues.

⚠️ Please be aware that using an older TRAKTOR KONTROL S2 Mk1 power supply will not provide enough power for your S2 Mk2 device to function.

**Connect the S2 to Your Computer via USB**

- Connect one end of the included USB 2.0 cable to the USB socket on the rear panel of your S2, and the other end to an available USB 2.0 port on your computer.

The TRAKTOR KONTROL S2 is a USB 2.0 device and will not work on a USB 1.0/1.1 port.
Turn Down All Volume Controls

► Before you plug any audio cable, make sure to turn down all volume controls, both on your S2 and on your amplification system. This will avoid any possible audio artifacts that could damage your speakers and your ears!
Connect the Main Outputs to Your Amplification System

► On the rear panel of your S2, connect the Main Output 1/2's 1/4" sockets (balanced) or the RCA sockets (unbalanced) to your amplification system, depending on the type of inputs supported by your amplifier or active speakers.
Connect your Headphones to the PHONES Socket (Front Panel)

► On the front panel of your S2, plug your headphones into the Headphones socket (PHONES).

Before putting on headphones, always make sure the headphone volume knob (CUE VOL) is set to minimum! To set the headphone volume to minimum, turn the CUE VOL knob counterclockwise until it reaches its end stop. Then, while playing music, slowly increase the headphone volume by turning the CUE VOL knob clockwise until it reaches the desired listening level.
Turn On Your S2

1. On the rear panel of your S2, engage the ON/OFF switch to switch on the device.

   ![ON/OFF switch](image)

2. Look at the top panel of your controller: after a quick LED animation, the USB indicator in the Master Display might flash for a few seconds, then it should stay lit. This confirms that your S2 is correctly recognized by your computer.

   If the USB indicator stays flashing, there is a problem with your USB connection and/or driver. Please refer to section ↑10.2, Hardware-related Problems for more info on how to solve this issue.

Start TRAKTOR

Start the TRAKTOR software, for example by double-clicking on its alias/shortcut on your desktop. The TRAKTOR window opens up.

Set the Deck Flavors in TRAKTOR

Instead of setting the Deck flavor manually as described here, you can also use the Setup Wizard: choose *2 Track Decks + 2 Remix Decks* in the menu, click *Finish*, and let the Wizard set everything for you. Bear in mind, though, that the Setup Wizard additionally resets all TRAKTOR settings to their default values. For more info on the Setup Wizard, please refer to section ↑8.4, The Setup Wizard.

In the TRAKTOR software, we set the lower Decks C and D to Remix Decks:
1. Open the Preferences window by clicking on the Preferences button in TRAKTOR’s Header:

![Mixer](image1)

2. Go to Preferences > Decks Layout > Deck Flavor and select Remix Deck in the C and D menus:

![Deck Flavor](image2)

3. Click Close at the bottom of the Preferences window to confirm your modifications.

**Notes**

- The MAIN LEVEL knob and meters at the top middle of your S2’s top panel allow you to adjust and monitor the overall output level:

![Main Level](image3)

- The CUE VOL and CUE MIX knobs on the S2 front panel respectively control the volume and the mix between the cued signal and the master signal in your headphones:

![Phones Cue Vol Mix](image4)
11.2 Adding a Microphone

Starting from the basic setup, we add here a microphone and show you how to use it on the MIC channel of TRAKTOR KONTROL 2.

Before you proceed, please follow the steps for the basic setup described in section ↑11.1, TRAKTOR KONTROL S2 Basic Setup.

Connect Your Microphone to the MIC Socket

Before you connect your microphone, make sure that the GAIN/FILTER knob next to the MIC socket is turned fully down!

1. At the very left on the rear panel of your S2, plug your microphone into the Microphone socket (MIC) located in the MIC section.
2. Press the MIC ENGAGE button on the left side of the S2's front panel.
3. Gradually bring up the volume with the mic's GAIN control on the rear panel of the S2.
12 Appendix B – Technical Information

You will find here the technical specifications of your TRAKTOR KONTROL S2.

12.1 Technical Specifications

Jacks and Sockets
- 1 input jack (MIC) for mono 6.3 mm (1/4 inch) phone plug
- 2 output jacks (MAIN OUT 1/2) for 6.3 mm (1/4 inch) TRS (balanced) phone plugs
- 2 output jacks (MAIN OUT 1/2) for mono (unbalanced) RCA plugs
- 1 microphone input with gain control and quick mute button
- 1 headphones jack for stereo 6.3 mm (1/4 inch) phone plug
- 1 Kensington lock slot
- 1 USB 2.0 Type B
- 1 power supply connector

12.2 Environmental Specifications

- **Operating temperature**: +5 to +35 °C (41 to 95 °F), max 85% non-condensing humidity
- **Storage temperature**: 0 to 40 °C (32 to 104 °F), max 85% non-condensing humidity

Do not install this unit in locations exposed to high humidity or direct sunlight.
13 Appendix C – Quick References

This appendix provides you with Quick Reference tables summing up the basic functionality of each control element on your TRAKTOR KONTROL S2. This gives you a quick and concise overview of all basic functions of your controller. For more info on each control element, please refer to the descriptions in chapter ↑6, Hardware Overview.

13.1 Quick Reference

See chapter ↑7, Hardware Control Reference for more details on these control elements.

<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remix Mode buttons A/B (below REMIX knob)</td>
<td>Switches the CUE/REMIX SLOTS buttons to Remix Deck mode. Lit when Remix Deck mode is enabled. See ↑7.5, Using the CUE/REMIX SLOTS Section for more info on the CUE/REMIX SLOTS section modes.</td>
</tr>
<tr>
<td>Load buttons A/B (below BROWSE encoder)</td>
<td>Normal: loads selected track on the respective Deck.</td>
</tr>
<tr>
<td></td>
<td>SHIFT: copies and pastes the content of the opposite Track Deck to the Deck.</td>
</tr>
<tr>
<td></td>
<td>Lights up when you press the jog wheel’s top plate.</td>
</tr>
<tr>
<td>Jog wheel</td>
<td>Outer rim: tempo bending.</td>
</tr>
<tr>
<td></td>
<td>Top plate: scratch control (direct control on playback position).</td>
</tr>
<tr>
<td></td>
<td>SHIFT + top plate: seek through track (fast forward / rewind).</td>
</tr>
<tr>
<td></td>
<td>In Loop: hold LOOP IN / LOOP OUT button and spin the jog wheel to fine-tune the Loop In Point / Loop Out Point.</td>
</tr>
<tr>
<td>Tempo fader</td>
<td>Increases/decreases Deck tempo.</td>
</tr>
<tr>
<td></td>
<td>Hold SHIFT to move the fader without altering the tempo.</td>
</tr>
<tr>
<td>FLUX buttons</td>
<td>Engage TRAKTOR’S Flux mode when pressed.</td>
</tr>
<tr>
<td></td>
<td>Press SHIFT + FLUX to reset a Deck’s tempo.</td>
</tr>
<tr>
<td>Control element</td>
<td>Function</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LOOP IN button</td>
<td>Sets a Floating Cue Point at the current playback position without stopping the playback. This Floating Cue Point will serve as Loop In Point when you press the LOOP OUT button (see below).</td>
</tr>
<tr>
<td></td>
<td>Lights up together with LOOP OUT when playback is within an active Loop.</td>
</tr>
<tr>
<td></td>
<td>In Loop: Hold to adjust Loop In Point with jog wheel.</td>
</tr>
<tr>
<td>LOOP OUT button</td>
<td>Sets a Loop Out Point at current playback position and activates a Floating Loop between the previously set Floating Cue Point and this Loop Out Point.</td>
</tr>
<tr>
<td></td>
<td>Looping active: Lights up together with LOOP IN when playback is within the active Loop, lights up alone when playback is outside the active Loop.</td>
</tr>
<tr>
<td></td>
<td>In Loop: Hold to adjust Loop Out Point with jog wheel.</td>
</tr>
<tr>
<td>LOOP MOVE encoder</td>
<td>deactivates the set loop.</td>
</tr>
<tr>
<td></td>
<td>When loop active: Turn to move the loop in steps of its size (as displayed in the Loop Controls in the software). SHIFT + turn to move the Loop by 1-beat steps.</td>
</tr>
<tr>
<td></td>
<td>When no loop active: Turn to jump in track by the selected Loop size (as displayed in the Loop Controls in the software). SHIFT + Turn to jump by 1-beat steps.</td>
</tr>
<tr>
<td>LOOP SIZE encoder</td>
<td>Push: deactivates/activates the loop. Activating looping automatically sets a Floating Loop at current playback position with the selected Loop size.</td>
</tr>
<tr>
<td></td>
<td>Turn (no loop active): selects a Loop size (in beats) for the next Floating Loop that will be set. The selected Loop size is displayed in the Loop Controls in the software.</td>
</tr>
<tr>
<td></td>
<td>Turn (loop active): halves/doubles the size of the current Loop.</td>
</tr>
<tr>
<td>PLAY button</td>
<td>Starts/stops playback. Button lights up when playing.</td>
</tr>
<tr>
<td></td>
<td>SHIFT + PLAY: activates/deactivates Keylock (KEYLOCK indicator right above the Loop In and Loop Out buttons in the software's Loop Controls lights up).</td>
</tr>
<tr>
<td>CUE button</td>
<td>Deck playing: jumps to Floating Cue Point and stops playback.</td>
</tr>
<tr>
<td></td>
<td>Deck paused: sets a new Floating Cue Point. Track is played back from that Floating Cue Point as long as CUE is held depressed. Upon release, playback stops and jumps back to Floating Cue Point.</td>
</tr>
<tr>
<td></td>
<td>SHIFT + CUE: skips back to start of track (playback state left untouched).</td>
</tr>
</tbody>
</table>
### 13.2 Mixer Quick Reference

The BROWSE encoder is covered in \(\uparrow13.3\), *FX Unit Quick Reference* below.

See chapter \(\uparrow7\), *Hardware Control Reference* for more details on these control elements.

#### 13.2.1 Main Section Quick Reference

<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAIN LEVEL knob</td>
<td>Adjusts the level of the signal sent to the Main Outputs of the S2.</td>
</tr>
</tbody>
</table>
### 13.2.2  Channel and Crossfader Quick Reference

<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
</table>
| GAIN encoder          | Turn: adjusts input gain level for that channel (before channel fader and MAIN volume control).  
                      | Push: resets input gain level to 0 dB.                                   |
| FX Assign buttons 1/2 | Normal: assigns the channel to FX Unit 1/2, respectively.               |
|                       | (For use with four FX Units, see detailed description in ↑7.8, Using the FX Units.) |
| High-frequency knob (HI) | Adjusts the high-frequency content of the signal.                      |
| Mid-frequency knob (MID) | Adjusts the mid-frequency content of the signal.                      |
| Low-frequency knob (LOW) | Adjusts the low-frequency content of the signal.                      |
| Headphone Cue button (CUE) | Sends the pre-fader signal to the cue channel (headphones).         |
| Channel fader         | Controls the channel's level.                                           |
| Channel meter         | Gives a visual feedback on the channel’s pre-fader level.               |
|                       | Blue: signal below clipping.                                            |
|                       | Red: signal clipping.                                                   |
| Crossfader            | Controls the mix between signals assigned to its both sides.           |

### 13.2.3  Master Display Quick Reference

<table>
<thead>
<tr>
<th>Control element</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alert indicator</td>
<td>Flashes when there is something wrong: Main Volume knob or Headphones Volume knob too low in the software, CPU load too high, laptop power supply disconnected.</td>
</tr>
<tr>
<td>USB indicator</td>
<td>Lit if the driver is up and running.</td>
</tr>
<tr>
<td></td>
<td>Flashing if there is no connection to the computer or a problem with the driver.</td>
</tr>
<tr>
<td>MIC indicator</td>
<td>Lit when a microphone input is enabled.</td>
</tr>
</tbody>
</table>
13.3  FX Unit Quick Reference

See section ↑7.8, Using the FX Units for more details on these control elements.

<table>
<thead>
<tr>
<th>Control element</th>
<th>Single mode</th>
<th>Group mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>FX On button</td>
<td>Normal: activates/deactivates FX Unit globally (lit when activated).</td>
<td>Normal: not used.</td>
</tr>
<tr>
<td></td>
<td>SHIFT: selects next FX from FX list (as set in Preferences &gt; Effects &gt; FX Pre-Selection).</td>
<td>SHIFT: loads a set of three predefined FX (as set in Preferences &gt; TRAKTOR KONTROL S2 &gt; S2 Control Options &gt; Direct FX 1-3).</td>
</tr>
<tr>
<td>FX DRY/WET knob</td>
<td>Adjusts the ratio between unprocessed (dry) signal and processed (wet) signal.</td>
<td></td>
</tr>
<tr>
<td>FX Knob 1-3</td>
<td>FX parameter 1-3 (FX-dependent).</td>
<td>Parameter for 1st, 2nd, and 3rd FX.</td>
</tr>
<tr>
<td>FX Button 1-3</td>
<td>FX Button 1: resets all FX parameters to their default value.</td>
<td>Activates/deactivates FX slot 1-3 (lit when slot activated).</td>
</tr>
<tr>
<td></td>
<td>FX Buttons 2 and 3: FX-dependent (lit when activated).</td>
<td>SHIFT + button: loads in this slot the next FX from FX list (as set in Preferences &gt; Effects &gt; FX Pre-Selection).</td>
</tr>
<tr>
<td></td>
<td>SHIFT + button: loads a predefined FX (as set in Preferences &gt; TRAKTOR KONTROL S2 &gt; S2 Control Options &gt; Direct FX 1-3).</td>
<td></td>
</tr>
</tbody>
</table>

13.4  Browsing, Loading and Copying Quick Reference

See section ↑7.9, Browsing, and Loading for more details on these control elements.
## Control element | Function
--- | ---
Load buttons A/B (below BROWSE encoder) | Normal: loads selected track on the respective Deck.  
SHIFT: copies and pastes the content of the opposite Track Deck to the Deck.  
Lights up when you press the jog wheel’s top plate.

BROWSE encoder | Turn: scrolls through the Playlist.  
SHIFT + turn: scrolls through the Browser Tree.  
SHIFT + press: expands/collapses folder nodes in the Browser Tree  
Push: activates/deactivates Browse mode.  
Push + turn: jumps through the Playlist by 10 steps.
Index

A

Absolute (prefs) [137]
Absolute mode [106]
Adjusting levels [37]
Alert indicator [124]
Aligning tracks [32]
Analysis [58]
Assigning FX to channels [55] [120]
Audience [38]
Audio interface [144]
Audio Processing (Control Panel) [146]
Audio Settings (Control Panel) [146]
Auto Loop (prefs) [137]

B

Basic setup [158]
Beat matching
  manually [34]
  quantized [32]
Beatgrid [58]
Beatjumps [108]
Beats
  manually aligning [36]
BPM [62]
BROWSE encoder
  Quick Loading [129]
Browsing from your S2 [128]
C

Calibration [139]
Changing the size of a Loop [42]
Channel [27] [91]
  CUE button [30] [123]
  fader [121]
  FX Assign buttons [120]
  HI knob [119]
  LOW knob [119]
  meter [121]
  MID knob [119]
  signal flow [118]
Channel fader [121]
Channel meter [121]
Clearing a Hotcue [44]
Clipping [37] [40]
Clock [59]
  panel [59]
  setting as tempo master [60]
  setting the Clock’s tempo (BPM) [62]
Collection [18]
Common setups [158]
Compatibility [14]
Connection Monitor (Control Panel) [149]
Control Panel [145]

Audio Settings page [146]
Diagnostics page [148]
Controller Editor [131]
Copying from your S2 [128]
Crossfader [34] [122]
CUE button (Deck)
  on Track Decks [114]
CUE button (Mixer) [123]
Cue channel [30]
CUE MIX knob [30] [96]
Cue Points
  Floating Cue Point [107]
  setting and storing [31]
CUE VOL knob [96]

CUE/REMIX SLOTS [110]
  Capture Sample [112]
  Cue Mode [110]
  Cue States [110]
  Deleting a Hotcue [111]
  Quick Loading Samples [113]
  Remix Deck Mode [111]
  Storing a Cue or Loop Point [111]

CUE/SAMPLES buttons [43]
Cueing [31] [41]
Customizing TRAKTOR KONTROL S2 [132]
Deactivating looping [44]
Deck [87]
   flavor [90] [140]
Default FX [54]
Device Monitor (Control Panel) [147]
Direct FX 1-3 (prefs) [136]
Distortion [38] [40]
Documentation
   Manual [12]
   Reading order [13]
   Setup Guide [12]
   TRAKTOR 2 Manual [12]
Driver issues [153]
Drop-Out Detection (Control Panel) [149]
DRY/WET knob (FX Unit) [57]
Dynamic range [37]

Effects [92]
EQs [119]
   using when mixing in a track [33]

Faders
   channel [121]
   TEMPO [105]
FILTER knob
   for mixing in a track [33]
Flavor (Deck) [90] [140]
Floating Cue Point [107]
Floating Loop [107]
FLUX Mode [75]
Front panel [95]
   Headphones socket (PHONES) [96]
   Headphones Volume knob (CUE VOL) [96]
   Microphone Volume knob (MIC VOL) [96]
FX
   default [54]
   loading (Group mode) [55]
   loading (Single mode) [56]
   synchronization [59]
   tempo-synched [56]
FX Assign buttons [120]
FX Unit [92]
   assigning to channels [55]
   controlling [55]
   DRY/WET knob [57]
Group mode [127]
Quick Reference [172]
reference [126]
Single mode [127]
n snapshot [57]

G
GAIN encoder [38]
GAIN/FILTER Encoder [118]
Group mode [127]
adjusting FX Dry/Wet balance [57]

H
Hardware Control Reference [102]
Headphone Cueing
   CUE MIX [70]
Headphones Cue button [123]
Headphones Mix knob (CUE MIX) [30] [96]
Headphones socket (PHONES) [96] [163]
Headphones Volume knob (CUE VOL) [96]
HI knob [119]
Hotcues [44]
   clearing [44]
   storing [31] [43]

I
Importing music [18] [19]
   from iTunes [20]
Information (Control Panel) [150]
Input routing [141]
iTunes [20]

J
Jog wheel
   on Track Decks [104]
   outer rim [36]
   top plate [36]

K
Kensington lock slot [93]
Key Functions Using TRAKTOR DJ
   Deck Volume Controls & Crossfader [65]
Keylock [63]
Knowledge Base [156]
Latency [144] [147]
LEDs (prefs) [140]
Level meters [38]
Levels
  adjusting [37]
Limiter [40]
Loading
  Samples [47]
  tracks [23]
Loading from your S2 [128]
Loop Buttons (prefs) [136]
LOOP IN button
  on Track Decks [107]
Loop mode [49] [114]
LOOP MOVE encoder
  on Track Decks [43] [108]
LOOP OUT button
  on Track Decks [107]
Loop Out Point [107]
Loop section
  on Track Decks [41] [107]
Loop Size Display [42]
Loop SIZE encoder
  on Track Decks [41] [109]
M
MAIN knob (software) [40]
Main level [39]
MAIN OUT section [94]
Main Outputs 1/2 [162]
Main section [92] [122]
Manual Looping (prefs) [136]
Manually cueing [35]
Master Display [123]
   Alert indicator [124]
   Preview Play indicator [124]
   USB indicator [124] [153]
Meters
   channel [121]
Metronome icon [59]
MIC VOL knob [96]
Microphone [166]
Microphone socket (MIC) [166]
Microphone Volume knob (MIC VOL) [96]
MID knob [119]
MIDI mode [130]
Mixer [90]
   channel [27] [91]
   Main section [92] [122]
   Master Display [123]
Quick Reference [170]
   reference [117]
Mixing
   by hand [34]
      using automatic sync [29]
Moving a Loop [43] [107]
Music files [18]
Music folders [19]
N
Navigate
   track by selected Loop size [43]
Noise level [37]
O
Offset
   manually correcting [36]
ON/OFF switch [95] [164]
One-shot mode [49]
Online Support Form [156]
Output Latency [147]
OUTPUTS Section
   BOOTH/MAIN Switch [94]
      Level Knob [94]
      MAIN Outputs [94]
      MAIN/BOOTH Outputs [94]
P
Phase offset (correcting) [36]
PHONES socket [96] [163]
Pitch (tracks) [63]
PLAY button (Deck)
on Track Decks [114]
Playing a track [23]
Playlist [90]
browsing [129]
POWER section [95]
Power supply [159]
Power Supply connector [95] [159]
Preferences [132]
Audio Setup page (Mac OS X) [144]
Audio Setup page (Windows) [145]
TRAKTOR KONTROL S2 page [134]
Preferences button [132]
Preferences icon [132]
Preparing the mix using headphones [30]
Preview Play indicator [124]
Process Buffer (Control Panel) [147]
Processing State (Control Panel) [147]

Q
QUANT button and indicator [32]
Quantize mode [32] [62]
Quick Loading
samples [128]
tracks [128]
Quick Overview [15]
Decks [16]
FX Units [17]
Mixer [17]
Quick Reference [168]
FX Unit [172]
Loading, copying [172]
Mixer [170]
Quick References [168]
Quick-loading
tracks [24]
R
Rear panel [93]
  MAIN OUT section [94]
  POWER section [95]
Recalibrating your S2 [139]
Relative (prefs) [137]
Relative mode [137]
Remix Deck [46]
  concept [90]
Remix Decks [15] [90]
REMIX knob [126]
Remix Mode Buttons [126]
Resetting TRAKTOR to default S2 settings [141]
Restoring the default settings [138]

S
Sample Rate
  Mac OS X [144]
  Windows [146]
Sample Slot [48] [90]
Samples [46] [90]
  capturing from a track [50]
  loading [47]
  playback mode [49]
  playing [49]
  stopping & skipping back to start [49]
  triggering [49]
  unloading [52] [114]
Scratching
  on a track [104]
Seeking through a track [104]
Selecting
  track [24]
Setting a Loop in a track [41] [107]
Settings button (prefs) [145]
Setup Wizard [141]
SHIFT button
  tapping [116]
Signal flow in channels [118]
Single mode [127]
Skipping back to start of track [33]
Snap mode [42] [52] [62]
Snapshot (FX Unit) [57]
Sockets [101]
  MIC [166]
  PHONES [96] [163]
  USB [95]
Storing a Cue Point [31]
Storing a Hotcue [31] [43]
Storing a Loop [43]
Switching between Deck flavors [140]
SYNC button
  on Track Decks [61] [115]
Synchronization [57]
Synchronizing tracks
  by hand [34]
  using automatic sync [30]
System requirements [14]

T
Technical Specs [167]
Tempo
  adjusting manually [35]
  automatically adjusting (Sync) [30]
Tempo bending
  on Track Decks [36] [104]
TEMPO Fader [105]
  Absolute mode [106]
  Relative mode [137]
Tempo Faders (prefs) [137]
Tempo master [58]
  setting a Track Deck as [61] [62] [116]
Tempo Offset buttons (OFFSET)
  in Relative mode [138]
Tempo Reset [106]
Track
  info [26]
  loading [23]
  playing [23]
Track Collection [18]
Track Deck [47]
  concept [90]
Track Decks [15] [90]
Tracks [90]